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2.5 Odstavcové styly . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
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2.7 Určenı́ sklonu čáry a vektoru . . . . . . . . . . . . . . . . . . . . . . . . . 75

2.8 Slunečnice . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83
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KAPITOLA 2

Typografický systém TEX

V této kapitole se budeme zabývat typografickým systémem TEX a předevšı́m jeho

nástavbou LATEX, ale jen v základnı́ch rysech. Struktura obsahu kapitoly je podobná

jako v kapitole o MS Wordu – typografická pravidla již vysvětlovat nebudeme, ale

ukážeme si, jak v LATEXu provést to, co jsme dělali v MS Wordu.

Čtenář se nemusı́ obávat přı́lišné náročnosti této problematiky. Jednotlivé po-

stupy jsou popisovány jako jakási „kuchařka“ a ukazovány na přı́kladech. Je použı́-

ván editor, který sice pracuje pouze s čistým textem, ale vyznačuje klı́čová (důležitá)

slova a téměř vše ze základů zde můžeme provádět klepánı́m na tlačı́tka panelů.

Narozdı́l od předchozı́ kapitoly zde nenajdeme tolik úloh. Předpokládá se, že

čtenář si znalosti procvičuje na uvedených přı́kladech.

2.1 Jak to všechno funguje

2.1.1 Princip překládaných dokumentů

MS Word a programy jemu podobné jsou označovány zkratkou WYSIWYG – What

You See Is What You Get, tedy dostaneš to, co vidı́š. Vidı́me zformátované stránky
s uplatněnı́m stylů, zobrazenými tabulkami, obrázky apod., a totéž dostaneme, když
dokument vytiskneme. Ono to až tak doslova někdy nebývá, ale to je zase trochu
jiný problém. WYSIWYG programy majı́ hodně výhod z hlediska koncového uživatele
(toho, kdo dokument vytvářı́), ale také hodně nevýhod plynoucı́ch většinou z toho,
že program musı́ pořád „myslet za uživatele“, někde uvnitř mı́t uloženy informace
o tom, jak má co vypadat a pořád to tak zobrazovat, pamatovat si pozici v dokumentu
a neustále „graficky“ reagovat na pokusy uživatele o změny v dokumentu.

Tohle všechno uhlı́dat a ještě k tomu nabı́zet možnost „uživatelsky přı́tulného“
přı́stupu ke všem možnostem nastavenı́ formátů je velmi náročné a dá se to zvlád-
nout jen bud’ vysokou spotřebou zdrojů počı́tače a složitostı́ prostředı́ programu,
nebo omezenı́m nabı́zených funkcı́, nebo tolerancı́ občasných chyb.

38



39 2.1 JAK TO VŠECHNO FUNGUJE

Program TEX (čteme [tech]) a jeho nástavba LATEX (čteme [latech] nebo [lejtech])
jdou jinou cestou. Vlastně se nejedná o žádný editor, je to pouze sada překládacı́ch
programů, které ze zdrojového souboru s přı́ponou TEX vyrobı́ cı́lový soubor s přı́-
ponou DVI, PS nebo PDF. Zdrojový soubor můžeme vyrobit v prakticky jakémkoliv
textovém editoru, který dokáže ukládat čistý text (třeba v Poznámkovém bloku), ale
lepšı́ je využı́t některý editor přı́mo k tomu určený, s tlačı́tky pro nejčastějšı́ akce.

Ve zdrojovém souboru vyznačujeme formátovánı́ a styly pomocı́ přı́kazů. Exis-
tuje napřı́klad přı́kaz, který určitý blok pı́smen (slov) zformátuje jako kurzı́vu, nebo
přı́kaz pro vysázenı́ nadpisu určité úrovně. Jiné přı́kazy sloužı́ k „provoznı́m úče-
lům“ – sdělujeme překládacı́mu programu, že se má použı́t česká znaková sada, jak
se majı́ formátovat odstavce, jaký základnı́ styl chceme pro dokument použı́t a kde
přesně v souboru začı́ná a končı́ vlastnı́ dokument.

Aby se nepopletly přı́kazy a samotný text, každý přı́kaz začı́ná znakem \ a jeho
parametry (upřesňujı́cı́ informace) se dávajı́ do složených {} (u povinných parame-
trů) nebo hranatých závorek [] (u nepovinných parametrů).

Práce v TEXu a LATEXu obnášı́ zhruba takový postup, jako když sedı́me u počı́tače
s někým jiným, koukáme mu přes rameno a diktujeme: Napiš článek v češtině,

kde nadpis bude „Postup výpočtu kvadratury kruhu“, autor budu já, datum tam

dej dnešnı́ (nevı́m, kterého je, zařid’ to nějak), v abstraktu napiš větu „V článku se

budeme věnovat různým postupům velmi zajı́mavého výpočtu kvadratury kruhu.“,

v kapitole s názvem Úvod bude tento text: „Škoda že dosud tento problém nebyl“, ted’

vyznačeně „uspokojivě“, konec vyznačenı́, dále „vyřešen. Proto se nám zde otevı́rá

poměrně široké pole působnosti“ atd.

Výpis č. 2.1 1

\typdokumentu{článek}
\jazyk{čeština}

\název{Postup výpočtu kvadratury kruhu}
\autor{já}
\datum{\dnes}

\začátek_dokumentu

\tady_bude_titul

\abstrakt{V článku se budeme věnovat
různým postupům velmi zajı́mavého výpočtu
kvadratury kruhu.}

\kapitola{Úvod}

Škoda že dosud tento problém nebyl
\vyznač{uspokojivě} vyřešen. Proto se
nám zde otevı́rá poměrně široké pole
působnosti

\konec_dokumentu

\documentclass{article}
\usepackage{czech}

\title{Postup výpočtu kvadratury kruhu}
\author{já}
\date{\today}

\begin{document}

\maketitle

\abstract{V článku se budeme věnovat
různým postupům velmi zajı́mavého výpočtu
kvadratury kruhu.}

\section{Úvod}

Škoda že dosud tento problém nebyl
\emph{uspokojivě} vyřešen. Proto se
nám zde otevı́rá poměrně široké pole
působnosti

\end{document}

1Všimněte si, že u jednoduchých dokumentů jde vlastně jen o to – znát pár anglických slovı́ček.
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Na výpisu 2.1 můžeme vidět způsob uvažovánı́ uživatele (v prvnı́m sloupci)
a vlastnı́ zdrojový kód dokumentu, na obrázku 2.1 výsledný vygenerovaný doku-
ment.

Postup výpočtu kvadratury kruhu

já

21. listopadu 2006

Abstrakt

V článku se budeme věnovat různým postupům velmi zajímavého vý-
počtu kvadratury kruhu.

1 Úvod

Škoda že dosud tento problém nebyl uspokojivě vyřešen. Proto se nám
zde otevírá poměrně široké pole působnosti

Obrázek 2.1: Ukázka jednoduchého dokumentu

Jak vidı́me, nemusı́me vůbec myslet na typ, řez a velikost pı́sma různých částı́
titulu, formát abstraktu, čı́slovánı́ kapitol (pak nenı́ problém kapitoly „přehazovat“),
způsob formátovánı́ vyznačeného textu – vše je nastaveno podle typografických pra-
videl. Prakticky do čehokoliv je možné zasahovat, ale většinou to nebývá potřeba.
Problém by snad mohl být se zapamatovánı́m přı́kazů (to nás však nemusı́ trápit,
pokud máme vhodný editor) a s tı́m, že u přı́kazů je potřeba dávat pozor na velká
a malá pı́smena – když mı́sto \date napı́šeme \Date, je to chyba.

Použı́váme zde dva různé pojmy – TEX a LATEX. Jaký je mezi nimi rozdı́l? Jde
předevšı́m o různé sady přı́kazů. LATEX je nástavbou TEXu, která má zjednodušit
vytvářenı́ běžných typů dokumentů, a tak kromě původnı́ch přı́kazů TEXu máme
k dispozici hodně dalšı́ch, které bychom jinak museli tvořit složitě pomocı́ sekvencı́
původnı́ch přı́kazů. V textu dále bude použı́ván pouze LATEX.

TEX (a LATEX) nenı́ jenom jeden. Existujı́ tzv. TEXovské distribuce, což je vždy sada
samotného TEXu, pomocných nástrojů a předevšı́m mnoha rozšiřujı́cı́ch balı́čků2.

2Třeba balı́ček czech pro české prostředı́, dalšı́ balı́čky s přednastavenými styly pro různé typy
dokumentů, použı́vánı́ barev, fonty, vlastnı́ definovánı́ záhlavı́ a zápatı́ stránky, speciálnı́ symboly pro
různé vědnı́ obory, atd.



41 2.1 JAK TO VŠECHNO FUNGUJE

U nás jsou pro Windows zřejmě nejoblı́benějšı́ distribuce MikTEX a TEXLive, na
Unixových systémech je hodně použı́vaný eTEX.

2.1.2 Jak vytvořit zdrojový soubor

Zdrojový soubor, jak je výše uvedeno, můžeme tvořit v téměř jakémkoliv textovém
editoru. Ideálnı́ je použı́t takový editor, který má v sobě (předevšı́m v menu a tlačı́t-
kách) zabudovánu podporu práce v TEXu a LATEXu.

Takových programů je poměrně hodně – namátkou TEXnicCenter, TEXShell,
TEXEdit, WinShell, WinEdt, ToolsCenter, EPM, Crimson Editor, PSPad, TEXMaker,
MED, LyX, . . . Jeden z mnoha seznamů oblı́bených editorů lze najı́t na [T30]. Každý
si může vybrat ten, který mu nejvı́c vyhovuje, většinou jde o volně šiřitelné programy
(až na některé – napřı́klad WinEdt je shareware, tedy oproti plné verzi má některá
omezenı́), najdeme je většinou na internetu.

Obrázek 2.2: Prostředı́ programu TEXnicCenter

Na obrázku 2.2 vidı́me prostředı́ jednoho z editorů, TEXnicCenter. Na hornı́m
okraji okna máme při ruce různé nástroje, které bychom mohli potřebovat (lze mě-
nit podle vlastnı́ch potřeb), dalšı́ jsou přı́stupné v menu. Dále máme k dispozici
dialogová okna, do kterých můžeme vyplňovat údaje potřebné k automatickému
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vygenerovánı́ některého přı́kazu. Ukázka jednoho takového dialogového okna pro
automatické vloženı́ přı́kazu generujı́cı́ho nadpis je na obrázku 2.3 na str. 42.

Obrázek 2.3: Dialog pro vytvořenı́ nadpisu a „záložky“, na kterou se lze odkazovat

2.2 Začı́náme

Předpokládejme, že máme nainstalovánu některou distribuci TEXu a vhodný editor.
Zde budeme použı́vat MikTEX verze 2.5 a editor TEXnicCenter verze 7.01, ale to,
co budeme dále probı́rat, je stejné téměř ve všech jiných použı́vaných distribucı́ch
a v některých podobných editorech.

Samotná instalace nenı́ zrovna triviálnı́ (předevšı́m nastavenı́ češtiny), stručný
postup instalace těchto verzı́ je na [P14].

Tak tedy máme spuštěn náš editor. Co ted’? Vlastně nic, můžeme přı́mo začı́t
psát náš text. Do nového souboru napı́šeme třeba větu, kterou se obvykle tes-
tuje správné nastavenı́ češtiny – když jsou všechna pı́smena správně „očárkovaná“
a „oháčkovaná“, je nastavenı́ vpořádku (uvedeno např. v [T31]). Samotná věta moc
smyslu nedává:

Přı́liš žlut’oučký kůň pěl d’ábelské ódy.

Ještě než pošleme tento soubor dále
na zpracovánı́, musı́me provést ještě
jednu věc – přidat přı́kazy, které LATEXu
řeknou, o jaký typ dokumentu se jedná,
že v souboru jsou znaky české abecedy
a kde začı́ná a končı́ vlastnı́ text doku-
mentu. Celý soubor bude vypadat tak
jako ve výpisu 2.2.

Výpis č. 2.2

\documentclass{article}
\usepackage{czech}

\begin{document}
Přı́liš žlut’oučký kůň pěl d’ábelské ódy.
\end{document}

Část zdroje mezi přı́kazy \begin{document} a \end{document} se nazývá tělo

dokumentu, část před přı́kazem \begin{document} se nazývá hlavička dokumentu

neboli preambule. Do preambule se umı́st’ujı́ předevšı́m informace o tom, jaké ba-
lı́čky se majı́ načı́st a jak má být co formátováno, tedy krátce řečeno, určujeme zde
styl dokumentu.

Náš soubor je už „přeložitelný“. Uložı́me ho s přı́ponou TEX (to je přı́pona zdro-
jových souborů dokumentů v TEXu a LATEXu) a vybereme si formát a přı́ponu pro
výsledný dokument. Máme tyto možnosti:
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PDF – tuto přı́ponu už známe. PDF dokument zde můžeme vygenerovat bez jakých-
koliv dalšı́ch pomocných programů, narozdı́l od MS Wordu. Soubor lze vytvořit
přı́mo nebo přes následujı́cı́ formát PS3. Pro jeho prohlı́ženı́ můžeme použı́t
třeba volně šiřitelný program Adobe Reader (ke stáhnutı́ na [P11]).

PS – PostScript je formát přı́buzný formátu PDF (dokonce má stejné tvůrce), jen je
staršı́ a soubory bývajı́ většinou většı́ než u téhož dokumentu ve formátu PDF.
Je vhodný zejména pro tisk, proto v tomto formátu máme dokumenty, které
se předevšı́m tisknou. Pro prohlı́ženı́ existuje napřı́klad program GSView.

Oproti Adobe Readeru tento prohlı́žeč zobrazený soubor po načtenı́ zavře a pra-
videlně ve velmi krátkých intervalech kontroluje, zda v souboru nedošlo ke
změnám. Pro uživatele to znamená, že před dalšı́m překladem mohou nechat
dokument zobrazený (nezavı́rat) a navı́c majı́ jistotu, že když se po následujı́-
cı́m překladu přepnou do GSView, vidı́ dokument v „čerstvém“ stavu, změny
jsou aplikovány.

DVI – je to zkratka z Device Independent, tedy „nezávislý na zařı́zenı́ “. Do tohoto
formátu se soubor překládá nejrychleji, je to původnı́ cı́lový formát TEXu. Ob-
vyklým prohlı́žečem je Yap (Yet Another Preview, je součástı́ distribuce MikTEX).

Formát přejı́má výhody formátu PS (před dalšı́m překladem nenı́ třeba výsledný
soubor zavı́rat a jsou hlı́dány změny), navı́c má výhodu rychlosti překladu. Ne-
výhodou je menšı́ rozšı́řenost tohoto formátu, když soubor s přı́ponou DVI zve-
řejnı́me na internetu nebo někomu pošleme, nenı́ moc velká pravděpodobnost,
že adresát bude vědět, co s nı́m.

Kdy který formát použı́t? Když se chceme na výsledek podı́vat během práce na
dokumentu, je nejlepšı́ přeložit soubor do DVI a podı́vat se na dokument v Yapu. Je
to nejrychlejšı́ a s použitı́m klávesové zkratky Alt + Tab máme téměř „WYSIWYG“
náhled. Hotový dokument pak zveřejňujeme v PS nebo PDF (nebo v obou formátech).

V programu TEXnicCenter použı́váme pro cokoliv souvisejı́cı́ho s překladem pa-
nel nástrojů zobrazený na obrázku 2.4.

1© Typ výstupu
H

2© Přelož!
H

3© Zobraz
výsledek!

4© Přelož a hned
zobraz výsledek!

�

Obrázek 2.4: Panel nástrojů s nástroji pro překlad dokumentu

Takže našı́m úkolem je nynı́ vybrat si typ výstupu v 1© (v našem přı́padě překlad
do DVI) a použı́t tlačı́tko 2© nebo 4©.

Prohlı́žeč Yap má oproti jiným ještě jednu důležitou výhodu – když v něm po-
klepeme myšı́ na některou část dokumentu, jsme automaticky přeneseni na dané
mı́sto ve zdroji dokumentu. U tak krátkého dokumentu, jaký jsme vytvořili, to nemá
moc velký význam, ale u dokumentu zabı́rajı́cı́ho několik desı́tek stránek přı́padně

3Přı́mé vytvořenı́ umožňuje lépe pracovat se stránkou a jinak obcházet omezenı́ daná formátem PS,
vytvořenı́ přes PS obvykle vytvořı́ menšı́ soubor.
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se zdrojem rozděleným do vı́ce souborů se to rozhodně hodı́. Pokud tato vlastnost
nepracuje jak má, můžeme ji nastavit v menu Yapu View → Options, záložka Inverse

DVI Search (obvykle stačı́ jen klepnout myšı́ na již vložený záznam, nemusı́me vkládat
nový).

2.3 Délkové jednotky

V kapitole jsme se na straně I seznámili s pojmem kuželka a určili stupeň pı́sma

jako výšku kuželky v typografických bodech. Z tohoto pojmu ted’ odvodı́me dalšı́
pojmy:

čtverčı́k (značı́me em) je mı́ra (tj. délka) odpovı́dajı́cı́ výšce kuželky (stupni), je to
přibližně výška pı́smene M (od toho také zkratka),

půlčtverčı́k (značı́me ex) je polovina čtverčı́ku, odpovı́dá přibližně výšce pı́smene x.

Pro délky můžeme využı́t přı́mo hodnoty em a ex (napřı́klad při nastavovánı́
vlastnostı́ odstavce – tyto délky se měnı́ se změnou velikosti pı́sma a odstavec pak
vypadá „stejně“), ale použı́vajı́ se i dalšı́ jednotky – pt (anglosaský typografický bod),
in (palec), cm, mm, . . . Mezi čı́slo a jednotku se nepı́še mezera.

Napřı́klad stupeň pı́sma bývá 10pt, 11pt, 12pt, odsazenı́ prvnı́ho řádku od-
stavce 2em, mezi dvěma odstavci, kde má čtenář na papı́ru něco doplnit, je třeba
mezera 4.5cm nebo .8em (před tečkou nemusı́ být žádná čı́slice – dosadı́ se 0).

2.4 Pı́smo

Ještě než se budeme věnovat možnostem nastavenı́ pı́sma, musı́me si ujasnit jednu
důležitou věc – použı́vánı́ lomených závorek. Lomené závorky {} určujı́ skupinu,
skupiny můžeme libovolně přidávat a vnořovat. Kdekoliv máme možnost stanovit,
že určitá vlastnost včetně vlastnostı́ pı́sma bude platit od mı́sta, kde ji určı́me, až
do nejbližšı́ho konce některé skupiny.

Skupinu určujı́ také některé přı́kazy, předevšı́m \begin a \end (oblast ohra-
ničená těmito dvěma přı́kazy se nazývá prostředı́) – napřı́klad „hlavnı́ skupinou“ je
tělo programu ohraničené přı́kazy \begin{document} a \end{document}.

2.4.1 Stupeň pı́sma

Stupeň pı́sma můžeme nastavit pro celý dokument hned na začátku, když TEXu
sdělujeme, jaký typ dokumentu chceme vyrobit:

\documentclass[12pt]{article}

Stupeň pı́sma zde zadáváme v nepovinném parametru (je v hranatých závorkách),
a to v typografických bodech (zkratka pt). Kolem závorek přı́kazu nepı́šeme mezeru,
přı́kaz musı́ být „kompaktnı́“.
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Obrázek 2.5: Panel nástrojů pro změnu stupně pı́sma

Přı́kaz Velikost

\tiny velmi velmi malé pı́smo

\scriptsize velmi malé pı́smo

\footnotesize malé pı́smo

\small menšı́ pı́smo

\normalsize normálnı́ velikost pı́sma
\large většı́ pı́smo
\Large ještě většı́ pı́smo
\LARGE velké pı́smo
\huge dost velké pı́smo
\Huge velmi velké pı́smo

Tabulka 2.1: Přı́kazy pro změnu stupně pı́sma

Při psanı́ občas také chceme změnit stupeň pı́sma. To provádı́me bud’na panelu
podle obrázku 2.5 nebo přı́kazy podle tabulky 2.1 na straně 45.

Tyto přı́kazy nemajı́ žádný parametr, jejich platnost je od mı́sta, kde je napı́-
šeme, do nejbližšı́ho konce skupiny. Odvı́jejı́ se od základnı́ho stupně pı́sma, který
jsme mohli určit v parametru přı́kazu \documentclass – tomu stupni odpovı́dá
přı́kaz \normalsize.

Základnı́ stupeň pı́sma dále můžeme (včetně řádkovánı́) určit přı́mo přı́kazem
\fontsize. Informace o tomto přı́kazu zı́skáme v nápovědě nebo v [T31].

Přı́klad 2.1 Na následujı́cı́ ukázce vidı́me, jak na čtenáře může působit častá
změna stupně pı́sma.

Výpis č. 2.3

\small Pokud chceme \normalsize vytvořit
{\Large esteticky zajı́mavý dokument}, hodně
\footnotesize často měnı́me velikosti pı́sma.
\normalsize Pro čtenáře to je moc dobrý
způsob, jak si nacvičit {\LARGE ničenı́}
dokumentu na jakýkoliv způsob.

Pokud chceme vytvořit esteticky
zajı́mavý dokument, hodně
často měnı́me velikosti pı́sma. Pro čte-
náře to je moc dobrý způsob, jak si

nacvičit ničenı́ dokumentu na
jakýkoliv způsob.

2.4.2 Nastavenı́ základnı́ch vlastnostı́ pı́sma

Řez (shape), tmavost (series) a rodinu (family) pı́sma nastavujeme jednoduše – bud’

použijeme tlačı́tka na hlavnı́m panelu (viz obrázek 2.6) nebo přı́mo přı́kazy.
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5© 6© 7© 8© 9© 10© 11© 12© 13© 14© 15© 16© 17© 18© 19© 20©

Obrázek 2.6: Panel nástrojů pro volbu řezu, tmavosti a rodiny pı́sma

Často nám úplně stačı́ přı́kaz \emph{vyznačený text} pro základnı́ vyznačenı́
(je přednastaven na kurzı́vu, i když to lze změnit), kterého jsme si mohli všimnout
už ve výpisu 2.1 na straně 39 – použijeme bud’ přı́mo tento přı́kaz nebo tlačı́tko

(podle obrázku 2.6 tlačı́tko 5©). Přı́kaz lze také vnořovat, pak dostaneme text
vyznačený ve vyznačeném textu, což představuje normálnı́ řez.

V tabulce 2.2 jsou vypsány různé přı́kazy nastavenı́ řezů, tmavosti a rodiny
pı́sma, a to nejdřı́v klasickým přı́kazem, jehož parametrem je text pro formátovánı́,
a pak s použitı́m skupiny – přı́kaz nemusı́ být na začátku skupiny, ale kdekoliv v nı́,
pak platı́ od mı́sta uvedenı́ přı́kazu do konce skupiny – nejbližšı́ho znaku }.

Řez Přı́kaz Tlačı́tko

kurzı́va (ithalic) \textit{kurzı́va} 7©
{\itshape kurzı́va} 15©

skloněné pı́smo (slanted) \textsl{skloněné pı́smo} 8©
{\slshape skloněné pı́smo} 16©

KAPITÁLKY (small caps) \textsc{kapitálky} 10©
{\scshape kapitálky} 17©

vzpřı́mené (vertical) \textup{vzpřı́mené}

{\upshape vzpřı́mené} 14©

Tmavost Přı́kaz Tlačı́tko

polotučné pı́smo (medium) \textmd{polotučné pı́smo}

{\mdseries popotučné pı́smo} 12©
tučné pı́smo (bold) \textbf{tučné pı́smo} 6©

{\bfseries tučné pı́smo} 13©

Rodina Přı́kaz Tlačı́tko

patkové (serif, roman) {\rmfamily patkové} 18©
bezpatkové (sans-serif) {\sffamily bezpatkové} 19©
neproporcionálnı́ (typewriter) \texttt{neproporcionálnı́} 9©

{\ttfamily neproporcionálnı́} 20©

Tabulka 2.2: Přı́kazy pro změnu řezu, tmavosti a rodiny pı́sma

Jak vidı́me, některé přı́kazy jakoby neměly na pı́smo žádný vliv. To je proto, že
napřı́klad vzpřı́mené patkové pı́smo je výchozı́, a dále přı́kaz pro polotučné pı́smo
ve většině typů pı́sem odpovı́dá normálnı́ tmavosti.

Pokud chceme zrušit všechny nastavené řezy, použijeme přı́kaz \upshape (tla-
čı́tko 14© – ), když chceme zrušit nejen nastavenı́ řezu, ale i tmavost nebo nepro-
porcionalitu, použijeme přı́kaz \normalfont (tlačı́tko 11© – ).
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LATEX má také speciálnı́ způsob formátovánı́ matematických výrazů (typograficky
správný). Zde se běžná velká i malá pı́smena abecedy sázejı́ skloněná nebo kurzı́vou
a symboly, které nejsou pı́smeny (včetně čı́sel), vzpřı́meným pı́smem, mezery mezi
symboly jsou jiné než v běžném textu. Pro řı́zenı́ formátu znaků zde máme k dispozici
přı́kazy \mathrm, \mathsf, \mathbf, \mathcal, \mathnormal, atd.

Přı́klad 2.2 Ukážeme si způsob použitı́ výše uvedených přı́kazů a možnosti jejich
kombinace.

Výpis č. 2.4

\textsc{Různé} způsoby \textbf{vyznačenı́} je
dobré znát, použı́váme jak \textit{tlačı́tka},
tak i přı́mo \textit{přı́kazy}.

Pro většinu vyznačenı́ existuje možnost
\textbf{dát vyznačovaný text do \itshape
parametru přı́kazu} a druhá možnost
{\bfseries s použitı́m \itshape skupiny}.

\emph{Musı́me dávat pozor, kde je vlastně
\emph{konec} té skupiny, ve které chceme
mı́t dané vyznačenı́!}

Přı́kazy \texttt{můžeme \bfseries
kombinovat}, ale {\sffamily ne vždy výsledek
vypadá \itshape pěkně}.

{\bfseries\slshape Pozor na mezery,
\normalfont zvláště u přı́kazů využı́vajı́cı́ch
skupiny!}

RŮZNÉ způsoby vyznačenı́ je dobré
znát, použı́váme jak tlačı́tka, tak
i přı́mo přı́kazy.

Pro většinu vyznačenı́ existuje
možnost dát vyznačovaný text do
parametru přı́kazu a druhá mož-
nost s použitı́m skupiny.

Musı́me dávat pozor, kde je vlastně

konec té skupiny, ve které chceme

mı́t dané vyznačenı́!

Přı́kazy můžeme kombinovat, ale
ne vždy výsledek vypadá pěkně.

Pozor na mezery, zvláště u přı́-
kazů využı́vajı́cı́ch skupiny!

Za přı́kaz využı́vajı́cı́ hranice skupiny vždy dáváme bud’mezeru nebo některé in-
terpunkčnı́ znaménko (tečka, čárka, pomlčka, apod.), abychom tento přı́kaz oddělili
od následujı́cı́ho slova.

Před takový přı́kaz bychom měli dát mezeru, protože mezera (i vı́ce mezer) za
přı́kazem se bere jako oddělovač přı́kazu a textu a tedy se do dokumentu nezahrnuje
– tedy napřı́klad počet\itshape žáků se vysázı́ jako početžáků.

2.4.3 Fonty

Jak vı́me z předchozı́ho textu, můžeme žádat jakékoliv změny mezi proporcionálnı́m,
patkovým a bezpatkovým pı́smem bez nutnosti „ručnı́“ změny fontu. Někdy ale
potřebujeme nastavovat fonty přı́mo, tedy určovat typ pı́sma dokumentu.

Narozdı́l od programů typu MS Word, které využı́vajı́ fonty instalované v operač-
nı́m systému, nemáme v TEXu takový výběr, použı́váme pouze fonty dodané přı́mo
s TEXem a těch roznodně nenı́ tolik. Je to předevšı́m z toho důvodu, že systém ob-
vykle nebývá použı́ván pro sazbu reklamnı́ch tiskovin, ale spı́še odbornějšı́ch článků
a knih.
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Nevýhodou je tedy menšı́ výběr, výhodou ale snadnějšı́ přenositelnost – fonty se
načı́tajı́ přı́mo do dokumentu, proto se nemůže stát, že když je dokument otevřen
na jiném počı́tači, fonty se nezobrazı́ správně.

Z typografických důvodů nenı́ moc vhodné měnit fonty v různých částech do-
kumentu, je zvykem mı́t nastaven jeden a tentýž font od začátku na celý dokument.
Zde si ukážeme jednoduchý způsob nastavenı́ fontu na začátku dokumentu.

Fonty se nacházejı́ v balı́čcı́ch, stejně jako čeština nebo různá nastavenı́ stylů,
proto je budeme načı́tat stejně jako ve výpisech 2.1 a 2.2 přı́kazem \usepackage.
Standardně je nastaven font Computer Modern. Můžeme vyzkoušet dalšı́ fonty:

• palatino,

• bookman,

• helvetica,

• optima,

• times,

• garamond,

• utopia,

• avantgar (pismo AvantGarde),

• zapfchan,

• . . .

Napřı́klad když si vybereme
prvnı́ možnost, font palatino, na-
pı́šeme do preambule někam hned
za \usepackage{czech} přı́kaz
\usepackage{palatino}, tak jak
vidı́me na výpisu čı́slo 2.5.

Každý z těchto fontů má tro-
chu jiné vlastnosti a možnosti po-
užitı́, proto je dobré alespoň něko-
lik vyzkoušet, než si definitivně vy-
bereme. Některé fonty nejsou defi-
novány pro některé řezy nebo tuč-
nost a při překladu je daná vlast-
nost bud’ pozměněna na základnı́,
nebo nahrazena z jiného fontu.

Výpis č. 2.5

\documentclass{article}
\usepackage{czech}
\usepackage{palatino}

\begin{document}
Toto je ukázka dokumentu, kde použı́váme font
\emph{palatino}.
Tento font má zajı́mavějšı́ kresbu než výchozı́
\emph{Computer Modern}, je výraznějšı́.

Předtı́m jsme byli pořád ve stejném odstavci,
i když jsme po prvnı́ větě zařádkovali,
ale ted’ po druhé větě jsme vložili prázdný
řádek, proto jsme vytvořili dalšı́ odstavec.
\end{document}

Jiný způsob nastavenı́ fontů spolu s dalšı́mi vlastnostmi je pomocı́ přı́kazů
\usefont, \fontencoding, \fontfamily, \fontseries, \fontshape, \fontsize,
těmito postupy se však zde nebudeme zabývat – jsou k nalezenı́ v nápovědě nebo
třeba v [T31, str. 153].

2.4.4 Zvláštnı́ znaky a sekvence znaků

Komentáře jsou části textu, které se ve výsledném dokumentu neobjevı́. Použı́váme
je pro vlastnı́ okomentovánı́ textu, napřı́klad informaci o tom, že na určitém
mı́stě ještě chceme něco doplnit či změnit, opticky oddělujeme různé části textu
nebo potřebujeme okomentovat přı́kaz, o kterém si myslı́me, že v budoucnu
budeme mı́t problémy s jeho pochopenı́m. Stačı́ napsat znak % (procento) a vše
za nı́m až do konce řádku bude bráno jako komentář.
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Spojovnı́k pı́šeme jednoduše klávesou s tı́mto znakem: bude-li, česko-anglický
slovnı́k.

Pomlčka se zadává jako dva spojovnı́ky za sebou bez mezery, tedy pı́šeme 10--15
minut, napsala -- pro upřesněnı́, zápas Sparta--Slavia. Dlouhou po-
mlčku pro anglické texty pı́šeme třemi spojovnı́ky --- (při obklopenı́ meze-
rami).

Nezlomitelná mezera taková, které je dovoleno se přı́padně rozšiřovat, se nahrazuje
vlnovkou ~, napřı́klad u~domu, s~mámou.

Pevná mezera (musı́ zůstat malá, při posouvánı́ slov pro rovný pravý okraj textu se
nesmı́ rozšiřovat) se zadává přı́kazem \,, napřı́klad 12\,450\,832, 10\,kg.
Často se mı́sto nı́ použı́vá nezlomitelná mezera (~).

Vybarvený obdélnı́k se sázı́ přı́kazem \rule{šı́řka}{výška} (zde jsou použity
parametry \rule{1em}{1ex}).

Pokud zadáme některý rozměr nulový, i tak se „zabere“ mı́sto, třebaže ob-
délnı́k neuvidı́me. Toho se často využı́vá při „nenápadném“ odsazenı́ objektu
zleva (\rule{odsazenı́}{0pt}) nebo shora (\rule{0pt}{odsazenı́}). V nepo-
vinném parametru můžeme zadat také posun nahoru nebo dolů, takto se dá
napřı́klad vytvořit mezera pod textem (napřı́klad \rule[-2em]{0pt}{1pt}).

Dlouhé horizontálnı́ mezery se zadávajı́ přı́kazy \quad (čtverčı́ková) a \qquad (dvou-
čtverčı́ková).

Vertikálnı́ mezery jsou \smallskip, \medskip a \bigskip pro malou, střednı́ a vel-
kou mezeru mezi odstavci (napřı́klad mı́sto, kde se má něco doplnit „ručně“),
s udánı́m délky \vspace{délka} – napřı́klad \vspace{2em}.

Pružné mezery jsou \vfill a \hfill. Horizontálnı́ mezera se může použı́t napřı́-
klad pro zarovnánı́ části textu k pravému okraji (třeba čı́slo stránky v obsahu).
Někdy je potřeba před a za tento přı́kaz vložit přı́kaz \rule s nulovou šı́řkou:
\rule{0pt}{1pt}\hfill\rule{0pt}{1pt}.

Pružné čáry se sázejı́ přı́kazy \hrulefill (plná čára) a \dotfill (tečkovaná).

Trojtečku vyrobı́ přı́kaz \dots, za tı́mto přı́kazem pı́šeme bud’ některé interpunkčnı́
znaménko (třeba čárku, ale určitě ne dalšı́ tečku!) a nebo, pokud má následo-
vat mezera, musı́me napsat prázdnou skupinu, aby mezera „nezmizela“, tedy
pı́šeme \dots{}.

Uvozovky pı́šeme přı́kazem \uv{text v uvozovkách} (výsledkem je „text v uvo-
zovkách“), úhlové jednoduše dvojicemi znaků >>text v uvozovkách<< (vý-
sledkem je »text v uvozovkách«).

Procento sice najdeme na klávesnici, ale musı́me použı́t přı́kaz \%, protože samotný
znak procenta je vyhrazen pro komentáře. Pı́šeme 10\,\% nebo 10~\%.
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TEX, LATEX, LATEX2ε vysázı́me přı́kazy \TeX, \LaTeX, \LaTeXe (to je označenı́ zatı́m
poslednı́ verze systému LATEX, čteme v češtině [latech dvě é]).

Stejně jako u jiných přı́kazů, pokud má následovat mezera, musı́me za přı́kaz
napsat prázdnou skupinu – \TeX{}. V přı́padě skloňovánı́ a ohýbánı́ slov toho
využijeme – napřı́klad slovo TEXový vysázı́me přı́kazem \TeX ový.

Slitky a podřezávánı́ (viz strana I) TEX dělá automaticky. Pokud se nám zrovna toto
chovánı́ nehodı́, vložı́me mezi dva znaky, které nechceme „spojit“, prázdnou
skupinu (bez mezery!) – napřı́klad mı́sto fi bude f{}i a mı́sto fi zı́skáme fi.

Promile, stupeň a dalšı́ symboly pı́šeme přı́kazy, jejichž seznamy najdeme i na
internetu, napřı́klad ve zdrojı́ch [T33] nebo [T34]. Někdy je třeba v preambuli doku-
mentu před přı́kazem \begin{document}) uvést balı́ček, ve kterém jsou tyto přı́kazy
určeny, napřı́klad když je v preambuli dokumentu \usepackage{textcomp}, mů-
žeme použı́vat přı́kazy \texttildelow (~), \textperthousand (‰), \textonehalf
(½), nebo třeba \textmusicalnote atd., v balı́čku gensymb najdeme mimo jiné
i přı́kazy \celsius (°C) nebo \degree (°).

V některých balı́čcı́ch jsou i symboly „ozdobné“ či „zábavné“, napřı́klad v balı́čku
marvosym je \Dontwash (Ý) nebo podobenka autora balı́čku \MartinVogel (ÿ).

Spousta přı́kazů pro symboly je však dostupná bez dalšı́ch přı́davných balı́čků,
napřı́klad \$ ($), \# (#), \{ ({), \& (&), \copyright (©), \texttrademark (™), $\ast$
(∗), $\times$ (×), $\alpha$ (α), atd. Mnohé najdeme v menu a na panelech editoru.

Některé zde uvedené přı́kazy jsou obklopeny znaky $ (napřı́klad $\ast$ nebo
znaky řecké abecedy). Je to z toho důvodu, že jde o symboly určené pro mate-
matickou sazbu (v rovnicı́ch apod.), a znaky $ se obklopuje právě prostředı́ pro
matematickou sazbu. To nám však nebránı́ tyto symboly použı́vat i v běžném textu,
stačı́ přı́kaz obklopit znaky dolaru.

Přı́klad 2.3 Všimněte si použitı́ obdélnı́ků na konci výpisu 2.6.

Výpis č. 2.6

Budeme-li v~\LaTeX u potřebovat komentář,
použijeme znak \% -- nic za nı́m nebude
v~dokumentu vidět, a~to ani ve dne
(6--19~hodin). % fakt!

Pro násobnost použı́váme znak $\times$,
napřı́klad $3\times$, a~to v~matematickém
prostředı́ ohraničeném třeba symboly \$.
Rovnice vložená do textu: $xˆ2-y+25=250$.
\hfill\rule{1ex}{1ex}

Telefonnı́ čı́slo můžeme zvýraznit symbolem
\Telefon{} z balı́čku \texttt{marvosym}.
Tento odstavec má už 13~řádků, je třeba ho
ukončit \Rightscissors.
\rule{.5ex}{1ex}
\rule{2pt}{0pt} % obdélnı́k s nulovou výškou
\rule[-1ex]{.5ex}{1ex} % snı́žený o 1ex

Budeme-li v LATEXu potřebovat ko-
mentář, použijeme znak % – nic
za nı́m nebude v dokumentu vidět,
a to ani ve dne (6–19 hodin).

Pro násobnost použı́váme znak ×,
napřı́klad 3×, a to v matematickém
prostředı́ ohraničeném třeba sym-
boly $. Rovnice vložená do textu:
x2 − y + 25 = 250.

Telefonnı́ čı́slo můžeme zvýraznit
symbolem T z balı́čku marvosym.
Tento odstavec má už 13 řádků, je
třeba ho ukončit Q.
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2.4.5 Diakritická znaménka

Diakritika obvykle nečinı́ problémy, lze použı́vat i diakritická znaménka, která ne-
máme dostupná na klávesnici. Napřı́klad \ˆ{a} nám vysázı́ â, \c{o} dává o̧, přı́kaz
\ae je pro æ. Podrobnějšı́ seznam je napřı́klad v [T31, str. 40] nebo v [T38, str.17].

Abychom nemuseli pro nezlomitelnou mezeru tak často psát vlnku (a tedy pře-
pı́nat mezi českou a anglickou klávesnicı́), existuje program, který to udělá za nás.
Jmenuje se vlna nebo vlna324. Program vlna32 (který budeme spı́še volit ve Win-
dows) se použı́vá takto:

vlna32.exe soubor.tex

kde soubor.tex je zpracovávaný soubor. Dále je nutné přidat cestu k programu
i zpracovávanému souboru.

Standardně bohužel program nezpracovává úplně vše, co by měl, ale máme
možnost určovat, za která jednopı́smenková slova bude vlnka přidána:

vlna32.exe -v KkSsVvZzOoUuAaIi soubor.tex

Tento způsob použı́vánı́ se může zdát poněkud pracný, ale pokud pracujeme
v editoru TEXnicCenter nebo jiném překládájı́cı́m v profilech, dá se trochu zautoma-
tizovat. Následujı́cı́ postup platı́ pro TEXnicCenter, v jiných editorech bude obdobný:

• v menu editoru najdeme okno Profiles (Build → Define output profiles),

• v okně vlevo dole klepneme na tlačı́tko Add,

• napı́šeme název profilu (třeba vlna) a potvrdı́me,

• v pravé polovině okna Profiles zaškrtneme polı́čka Do not use BibTeX . . . a Do not
use MakeIndex . . . (odtud se nic spouštět nebude) a přepneme se na druhou
záložku (Postprocessor),

• tam přidáme nový program (vlevo nahoře tlačı́tko se čtverečkem), napı́šeme
jeho název (je jedno jaký, třeba vlna) a do řádků nı́že zadáme:

– doplnı́me nebo najdeme (tlačı́tko vedle pole Path) adresu k programu
vlna32.exe,

– doplnı́me argumenty přı́kazu (Command line arguments)

-v KkSsVvZzOoUuAaIi ”%pm”

(to znamená, že že se bude vlnka doplňovat za uvedená samotná pı́smena
a %pm se nahradı́ názvem toho souboru, se kterým právě pracujeme).

Pak stačı́ vždy jen zvolit tento profil v rozbalovacı́m seznamu na hlavnı́m panelu
a klepnout na tlačı́tko pro překlad.

4Program si můžeme stáhnout na ftp://math.feld.cvut.cz/pub/olsak/vlna/. Potřebujeme
soubor vlna.exe nebo vlna32.exe a dále soubor vlna.txt, kde je popsáno, jak se tento soubor
použı́vá.

ftp://math.feld.cvut.cz/pub/olsak/vlna/
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2.5 Odstavcové styly

2.5.1 Prostředı́

Prostředı́ je úsek textu, který má být určitým způsobem zformátován. Až na vyjı́mky
vyznačujeme začátek prostředı́ přı́kazem \begin{název prostředı́} a konec přı́-
kazem \end{název prostředı́}. Každé prostředı́ je zároveň skupinou (viz kap. 2.4,
str. 44), tedy přı́kazy s platnostı́ do konce skupiny (třeba pro změnu stupně pı́sma)
končı́ svou platnost nejen u nejbližšı́ho výskytu }, ale také \end{...}.

V LATEXu se běžně použı́vá mnoho různých prostředı́ – napřı́klad center pro
zarovnánı́ úseku textu na střed, quotation pro sazbu citátů, itemize jako výčtové
prostředı́ s odrážkami, máme také několik matematických a tabulkových prostředı́
i prostředı́, ve kterých se přı́kazy nevyhodnocujı́ a považujı́ se za běžný text. Někte-
rými z nich se budeme zabývat v následujı́cı́m textu, informace o dalšı́ch najdeme
napřı́klad v [T31], [T36], [T37] a dalšı́ch.

2.5.2 Formát odstavce

Parametry odstavce nastavujeme (většinou v preambuli – hlavičce – dokumentu)
přı́kazy podle tabulky 2.35. Pro vertikálnı́ odsazenı́ odstavců a odstavcovou zarážku
použı́váme násobky délek ex a em. Jsou odvozeny z rozměrů kuželky momentál-
nı́ho stupně pı́sma, proto po změně stupně pı́sma nebo fontu se optické vlastnosti
odstavce přı́liš nezměnı́.

Ukázka přı́kazu Význam

\setlength{\parskip}{1ex}6 nastavı́ vertikálnı́ odsazenı́ od-
stavců na půl délky ex

\setlength{\parindent}{2em} nastavı́ odsazenı́ prvnı́ho řádku
odstavce (zarážky) na 2em

\def\baselinestretch{1.5}\normalsize nastavı́ řádkovánı́ na 1,5 násobek
běžného řádkovánı́

Tabulka 2.3: Nastavenı́ parametrů odstavce

Odstavce oddělujeme prázdným řádkem nebo přı́kazem \par, prvnı́ možnost
je samozřejmě jednoduššı́. Dále máme možnost přerušit řádek kdekoliv uprostřed
odstavce přı́kazem \\ nebo \newline tak, že na novém řádku nebude použito žádné
odsazenı́ (prostě se jen přesuneme na nový řádek). Zároveň můžeme i vynechat
mı́sto, velikost mezery udáváme v nepovinném parametru – napřı́klad \\[2em]. Pro
ukončenı́ stránky použijeme přı́kaz \newpage.

Běžný text je zarovnán do bloku, tedy levý i pravý okraj jsou rovné. To máme
možnost změnit a nastavit zarovnánı́ na střed nebo na praporek – praporek vlajı́cı́

5V prvnı́ch dvou přı́padech jde o práci s tzv. délkovými registry (délkami), jakýmisi zástupnými
názvy pro často použı́vané délky. V registru \parskip je uložena vzdálenost mezi odstavci, v registru
\parindent velikost odstavcové zarážky.

6Zde je vhodné dát určitou rezervu, aby TEX při vkládánı́ konce stránky měl možnost mı́rně „pružně“
upravit vzdálenosti mezi odstavci. Pokud to neuděláme, TEX si ji stanovı́ sám tak, že se nám to nemusı́
lı́bit. Přı́kaz může vypadat napřı́klad takto: \setlength{\parskip}{1ex plus .3ex minus .2ex}.
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vpravo („zubatý“ text vpravo, rovný vlevo) je zarovnánı́ vlevo, praporek vlajı́cı́ vlevo
je zarovnánı́ vpravo.

Zarovnánı́ Přı́kaz

na střed \begin{center} ... \end{center}
{ ... \centering ... }

vlevo (praporek doprava) \begin{flushleft} ... \end{flushleft}
{ ... \raggedright ... }

vpravo (praporek doleva) \begin{flushright} ... \end{flushright}
{ ... \raggedleft ... }

Tabulka 2.4: Možnosti zarovnánı́ textu

V tabulce 2.4 máme u každé možnosti dva způsoby, jak určitého zarovnánı́
dosáhnout. Prvnı́ je pomocı́ prostředı́, druhá přı́kazem platným do konce skupiny
(ve skutečnosti platı́ už od začátku odstavce, ve kterém se nacházı́). Většinou je
lepšı́ použı́t prostředı́, druhý způsob je vhodný třeba při umı́st’ovánı́ obrázku nebo
tabulky. Když nechceme psát přı́kazy, můžeme využı́t menu nebo hlavnı́ panel edi-
toru, kde najdeme tlačı́tka podobná těm z Wordu.

Výpis č. 2.7

Zatı́m ještě máme odstavce zarovnány do
bloku, ale to brzy změnı́me hned po\\
ukončenı́ řádku uvnitř
odstavce.

\begin{flushright}
Toto je ukázka zarovnánı́ textu k~pravému
okraji. Platı́ až do konce prostředı́,
jestliže zarovnánı́ nezměnı́me některým
přı́kazem.

Tento\centering text je centrován, a~to již
od začátku odstavce.
\end{flushright}

Vracı́me se k~zarovnánı́ do bloku, předchozı́
prostředı́ už skončilo.

Zatı́m ještě máme odstavce zarov-
nány do bloku, ale to brzy změ-
nı́me, hned po
ukončenı́ řádku uvnitř odstavce.

Toto je ukázka zarovnánı́ textu
k pravému okraji. Platı́ až do

konce prostředı́, pokud zarovnánı́
nezměnı́me některým přı́kazem.

Tento text je centrován, a to již od
začátku odstavce.

Vracı́me se k zarovnánı́ do bloku,
předchozı́ prostředı́ už skončilo.

Pokud je určeno nenulové odsazenı́ prvnı́ho řádku (tzv. odstavcová zarážka),
můžeme použı́vánı́ této zarážky řı́dit přı́kazy \noindent (pro tento odstavec se ne-
použije) a \indent (pro tento odstavec se použije). Druhý přı́kaz je užitečný napřı́-
klad tehdy, když se zarážka použı́vá pro všechny odstavce kromě prvnı́ho v kapitole,
a my vyjı́mečně chceme odsadit i ten prvnı́. Oba přı́kazy pı́šeme těsně před začátek
odstavce, pro který majı́ platit:

\noindent
text odstavce, který nemá mı́t odsazený prvnı́ řádek

Odstavce mohou být pojmenované. Takto lze nenásilně bez nadpisů členit přı́liš
dlouhou kapitolu, ve které se určité odstavce týkajı́ vždy určitého tématu. Název
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odstavce je formátován tučně stejně jako názvy kapitol, to ale můžeme změnit pou-
žitı́m přı́kazu \normalfont a přı́kazu pro vybraný formát.

Výpis č. 2.8

\paragraph{Pojmenovaný odstavec.}
Pojmenované odstavce použı́váme pro
podrobnějšı́ členěnı́ kapitoly, kde
odstavce lze pojmenovat jejich
tématem. Všimněte si vyznačenı́
pojmenovánı́ a~odsazenı́ textu.

Někdy odstavec nelze pojmenovat -- pak
ho necháme tak, jak je. Obvykle se
počı́tá s~tı́m, že tematicky patřı́
k~předchozı́mu odstavci.

\paragraph{Nadpisy.} Nadpisy obvykle
členı́me do úrovnı́, ale maximálně čtyř,
ideálně třı́. Pro podrobnějšı́ členěnı́
můžeme použı́t pojmenované odstavce.

Pojmenovaný odstavec. Pojmenované
odstavce použı́váme pro podrobnějšı́ čle-
něnı́ kapitoly, kde odstavce lze pojmeno-
vat jejich tématem. Všimněte si vyzna-
čenı́ pojmenovánı́ a odsazenı́ textu.

Někdy odstavec nelze pojmenovat – pak
ho necháme tak, jak je. Obvykle se počı́tá
s tı́m, že tematicky patřı́ k předchozı́mu
odstavci.

Nadpisy. Nadpisy obvykle členı́me do
úrovnı́, ale maximálně čtyř, ideálně třı́.
Pro podrobnějšı́ členěnı́ můžeme použı́t
pojmenované odstavce.

2.5.3 Seznamy

V LATEXu použı́váme tři druhy výčtových seznamů – výčtové (itemize), čı́slované (enu-

meration) a s popisky (s pojmenovanými položkami, description). Všechny tři druhy
jsou tvořeny prostředı́m a položky začı́najı́ přı́kazem \item. U všech třı́ druhů mů-
žeme v nepovinném parametru položky určit „popisek“, který však využijeme ob-
vykle pouze u seznamu s popisky (to budou ty popisky), jinak tı́mto způsobem lze
napřı́klad změnit symbol pro odrážku.

Strukturu seznamu vytvořı́me bud’ ručně podle přı́kladu 2.4 nebo pomocı́ tlačı́-
tek na hlavnı́m panelu či položkami v menu (Insert→ Enumerations), položky seznamu
vložı́me tamtéž (. . . Entry). V jednom prvku seznamu může být vı́ce odstavců.

V přı́kladu 2.4 je ve výpisu 2.9 ukázán způsob změny symbolu pro odrážku
(v tomto smyslu však moc nepoužı́váme), ve výpisu 2.10 vidı́me možnost odkazovánı́
se na jednotlivé položky čı́slovaného seznamu (je to použitelné i mimo seznam), ve
výpisu 2.11 je pozměněn formát poslednı́ho popisku.

Přı́klad 2.4 Ve třech výpisech vidı́me ukázku použitı́ základnı́ch druhů seznamů.

Výpis č. 2.9

Výčtový seznam:
\begin{itemize}
\item prvnı́ odrážka,
\item druhá odrážka,
\item[\CheckedBox] třetı́ odrážka.
\end{itemize}

Výčtový seznam:

• prvnı́ odrážka,

• druhá odrážka,

2� třetı́ odrážka.
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Výpis č. 2.10

Vztahy mezi zvı́řaty,
odkaz na \ref{seznam:kocka}:
\begin{enumerate}
\item Pes.
\item\label{seznam:kocka} Kočka.
\item Myš utı́ká před tı́m, co je v~položce

\ref{seznam:kocka}.
\end{enumerate}

Vztahy mezi zvı́řaty, odkaz na 2:

1. Pes.

2. Kočka.

3. Myš utı́ká před tı́m, co je v po-
ložce 2.

Výpis č. 2.11

Seznam s~popisky:
\begin{description}
\item[Spojovnı́k] pı́šeme jednoduše klávesou

s~tı́mto znakem.
\item[Pomlčka] se zadává jako dva

spojovnı́ky.
\item[\normalfont\itshape Nezlomitelná

mezera] se nahrazuje vlnovkou.
\end{description}

Seznam s popisky:

Spojovnı́k pı́šeme jednoduše klá-
vesou s tı́mto znakem.

Pomlčka se zadává jako dva spo-
jovnı́ky.

Nezlomitelná mezera se nahrazuje
vlnovkou.

Výpis č. 2.12

Vı́ceúrovňové čı́slovánı́:
\begin{enumerate}
\item Toto je prvnı́ úroveň, prvnı́ odstavec.

Tady je druhý odstavec.
\item Dalšı́ položka prvnı́ úrovně.

\begin{enumerate}
\item Toto je druhá úroveň.
\item Dalšı́ položka.
\end{enumerate}

\end{enumerate}

Vı́ceúrovňové čı́slovánı́:

1. Toto je prvnı́ úroveň, prvnı́
odstavec.

Tady je druhý odstavec.

2. Dalšı́ položka prvnı́ úrovně.

(a) Toto je druhá úroveň.

(b) Dalšı́ položka.

Výpis 2.12 je ukázkou možnosti vnořovánı́ výčtových prostředı́, čı́mž vzniká
třeba vı́ceúrovňové čı́slovánı́. Seznamy můžeme libovolně kombinovat včetně růz-
ných typů, LATEX se vždy sám postará o vhodné odlišenı́ úrovnı́. Jen si musı́me dávat
pozor na „překřı́ženı́ “ začátků a konců různých prostředı́.

Vlastnosti prostředı́ pro seznamy se určujı́ obvykle hned za úvodnı́m přı́kazem
prostředı́. Napřı́klad vertikálnı́ mezery mezi položkami seznamu změnı́me takto:

\begin{itemize}\setlength{\itemsep}{0pt} \item ...

U seznamů se dále mohou hodit délkové registry \partopsep, \labelsep,
\itemindent, \leftmargini, \leftmarginii, \leftmarginiii, \leftmarginiv.
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2.6 Dokumenty

2.6.1 Třı́da dokumentu

Typ (třı́du) dokumentu určujeme v přı́kazu \documentclass. Standardnı́ třı́dy jsou:

article – podle názvu by se mohlo zdát, že je použitelná pouze pro články, ale
je to nejpoužı́vanějšı́ třı́da pro běžné texty do velikosti několika desı́tek stran.
Výchozı́ nastavenı́ je jednostranný dokument.

report – třı́da vhodná pro dokumenty v délce několika desı́tek až stovek stran,
výchozı́ nastavenı́ je jednostranný dokument.

book – třı́da vhodná pro rozsáhlé dokumenty. Oproti třı́dě report je nastaven obou-
stranný dokument a jinak zformátováno záhlavı́ a zápatı́.

letter – třı́da pro psanı́ dopisů.

Nejčastěji budeme použı́vat třı́du article.

Zároveň s určenı́m třı́dy obvykle nastavujeme některé vlastnosti, které se nám
ve výchozı́m nastavenı́ nelı́bı́. Tyto vlastnosti se uvádějı́ do nepovinného parame-
tru. Napřı́klad když chceme použı́t třı́du article, ale nastavit rozměr stránky A4,
stupeň pı́sma 12 a oboustranný dokument, uděláme to takto:

\documentclass[a4paper,12pt,twoside]{article}

Nikde neděláme mezery, vlastnosti mohou být v jakémkoliv pořadı́.

Kromě standardnı́ch třı́d existujı́ ještě dalšı́ třı́dy, obvykle vytvořené lidmi k urči-
tému konkrétnı́mu účelu. Hodně třı́d je pro vytvářenı́ prezentacı́ (napřı́klad beamer,
prosper, ifmslide, texpower, elpres), zası́lánı́ článků do odborných časopisů
(paper, llncs, elsevier, acmtrans2e, amsart, nature), diplomové a disertačnı́
práce (scrreprt, scrartcl, adfathesis, classicthesis, ua-thesis), referenčnı́
manuály (refart, refrep), odborné knihy a beletrii (scrreprt, scrbook, hitec,
memoir, octavo, amsbook), životopisy (cv, moderncv), letáky (leaflet), laboratornı́
záznamy (labbook), postery (plakáty většinou v rozměru A0, použı́vajı́ se napřı́-
klad na konferencı́ch pro grafickou prezentaci výsledků výzkumu, máme možnost
určovat pozici jednotlivých objektů či textu na stránce) (a0poster) atd.

Seznamy z předchozı́ho odstavce rozhodně nejsou kompletnı́. Počet těchto třı́d
je různý v různých distribucı́ch TEXu, je jich však vı́ce, než běžný uživatel tušı́ (běž-
nému uživateli ostatně stačı́ standardnı́ třı́dy). Později, v kapitole 2.6.2, si ukážeme,
jak o nich najı́t informace (tyto třı́dy se lišı́ nejen nastavenı́m stylů, tedy „vizuálně“,
ale někdy i způsobem použitı́ – definovanými přı́kazy) a jak je využı́t v dokumentech.

2.6.2 Styly

Podobně jako jiné systémy, i LATEX umožňuje ovlivňovat vzhled dokumentu úpra-
vou stylů. Pro jednoduššı́ dokumenty dostačujı́ předdefinované styly (pro odstavce,
nadpisy apod.), tyto styly lze ovlivňovat následovně:

1. Výběrem třı́dy dokumentu. Každý dokument má přiřazenu právě jednu třı́du,
která stanovı́ základnı́ vzhled a strukturu a přı́padně přidává některé specifické
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přı́kazy, prostředı́ a objekty k té třı́dě, ze které je odvozena. S některými třı́dami
jsme se seznámili v kapitole 2.6.1, tedy už vı́me, že třı́da se načı́tá přı́kazem

\documentclass[nepovinné argumenty]{název třı́dy}

Napřı́klad \documentclass[a4paper,11pt,twoside]{report} znamená, že
pro dokument chceme použı́t třı́du report, budeme tisknout na papı́r formátu
A4, velikost pı́sma je 11 bodů a jde o oboustranný dokument.

2. Načtenı́m balı́čku. V balı́čku (package) je nadefinován nebo pozměněn jen jeden
nebo vı́ce stylů nebo je vytvořen nový přı́kaz či prostředı́ pro některý konkrétnı́
účel, obvykle lze balı́ček použı́vat zároveň s jinými balı́čky nebo kteroukoliv
třı́dou. Už dřı́ve jsme použı́vali přı́kaz pro načtenı́ balı́čku

\usepackage[nepovinné argumenty]{název balı́čku}

Nepovinné argumenty jsme u balı́čků ještě nepoužı́vali, seznámı́me se s nimi
napřı́klad u balı́čku hyperref nebo color.

V jednom přı́kazu \usepackage můžeme načı́st vı́ce balı́čků, jak uvidı́me v přı́-
kladu 2.5.

3. Změna nebo vytvořenı́ stylu přı́mo v dokumentu. V dokumentu, obvykle v jeho
hlavičce (preambuli), si můžeme vytvořit vlastnı́ přı́kazy nebo prostředı́ nebo
pozměnit existujı́cı́. Ve většině přı́padů použı́váme přı́kazy \def, \newcommand,
\renewcommand, \newenvironment, \renewenvironment nebo pro nastavenı́
délek \setlength. Pro čı́slované prostředı́ je výhodné použı́t třeba přı́kaz
\newtheorem v kombinaci s jiným přı́kazem. Ukázky použitı́ těchto přı́kazů
jsou ve výpisu 2.14 v přı́kladu 2.5.

4. Jiné. Některé styly se načı́tajı́ trochu jiným způsobem. Jde napřı́klad o různé
typy a řezy pı́sma. My jsme si v kapitole 2.4.3 o fontech ukazovali změnu typu
pı́sma načtenı́m balı́čku, ale obvyklejšı́ (a o něco složitějšı́) cesta je pomocı́
dalšı́ch přı́kazů (viz [T31]). Dále některé zvláštnı́ řezy pı́sma se načı́tajı́ trochu
netradičně, napřı́klad řez tapı́r se použı́vá takto:

Výpis č. 2.13

% inicializace třeba v preambuli dokumentu:
\font\tapir tap

% použı́vánı́ kdekoliv v dokumentu:
{\tapir Tento text je psán řezem tapı́r.\par Bohužel
v~něm nefungujı́ kombinace s~dalšı́mi řezy.}

Přı́klad 2.5 Ve výpisu máme ukázku jednoduché preambule dokumentu typu člá-
nek (article) s fontem bookman a také vidı́me způsob použitı́ výše uvedených
přı́kazů pro definovánı́ nových přı́kazů či stylů. Přı́mo z přı́kladů lze odvodit způsob
použı́vánı́ jednotlivých přı́kazů včetně potřebných argumentů.
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Výpis č. 2.14

\documentclass[a4paper,12pt]{article}
\usepackage{czech,a4wide,comment} % nikde v parametrech nesmı́ být mezera!!!

% balı́ček a4wide zajistı́ obvyklé rozměry okrajů stránky pro formát A4,
% balı́ček comment umožnı́ použı́vat prostředı́ comment pro vı́ceřádkové komentáře
% \begin{comment} ... \end{comment}

\usepackage{bookman}

\usepackage{textcomp,gensymb,marvosym,wasysym} % balı́čky s různými symboly

% přı́kaz \zahlavitabulky se použije pro styl záhlavı́ tabulky, na tomto mı́stě
% (v preambuli dokumentu) to lze jednoduše změnit pro celý dokument:
\def\zahlavitabulky{\bfseries}

% vytvářı́me vlastnı́ přı́kaz s jednı́m parametrem:
\newcommand{\kolecko[1]{\textcircled{\tiny #1}}
% použı́vá se napřı́klad takto: \kolecko{10} - vytvořı́ čı́slo 10 v kolečku

% vytvořı́me jednoduché prostředı́ mı́rně pozměňujı́cı́ původnı́ prostředı́ itemize,
% pozměnı́me mezery mezi položkami seznamu (všimněte si strukturovánı́ přı́kazu
% pomocı́ komentářů):
\newenvironment{mitemize}%

{\begin{itemize}\setlength{\itemsep}{0pt}}%
{\end{itemize}}

% použı́vá se: \begin{mitemize} ... \end{mitemize}

% následujı́cı́ prostředı́ sloužı́ k vhodnému formátovánı́ poznámek - na začátku
% slovo Poznámka následované mezerou a na konci podtrženı́ celého odstavce:
\newenvironment{poznamka}%

{\textbf{Poznámka:\quad}}%
{\newline\rule{0pt}{1pt}\hrulefill\rule{0pt}{1pt}}

% potřebujeme čı́slované prostředı́ priklad, čı́slovánı́ bude záviset na čı́slu
% kapitoly,využijeme kombinaci newtheorem a newenvironment:
\newtheorem{thpriklad}{Přı́klad}[chapter]
\newenvironment{priklad}%

{\begin{thpriklad}\rule{1pt}{0pt} \normalfont}%
{\end{thpriklad}}

% použı́vá se: \begin{priklad} ... \end{priklad}

U přı́kazů \def a \newcommand jsou argumenty celkem jasné – je potřeba pouze
zadat, co se stane, když je vytvářený přı́kaz použit, v nepovinném parametru mů-
žeme určit přı́padné parametry přı́kazu (pro \def viz nápověda).

U přı́kazu \newenvironment, který vytvořı́ nové prostředı́, zadáváme po jeho
názvu nejdřı́v, co se má provést při \begin{nové prostředı́}, tedy na jeho za-
čátku, a v dalšı́m argumentu určı́me, co se má provést při \end{nové prostředı́}.
U prostředı́ definovaného přı́kazem \newtheorem obvykle pouze určı́me jeho název
a vazbu čı́slovánı́ (máme vı́ce možnostı́, než je zde naznačeno, podrobnosti najdeme
v nápovědě).

Častou a nenápadnou chybou je „chaos“ v závorkách. Když nám program hlásı́
při překladu chybu souvisejı́cı́ se závorkami nebo s hranicemi prostředı́, nezbývá
nic jiného než počı́tat levé a pravé závorky a kontrolovat jejich umı́stěnı́. Zde se
vyplácı́ psát přehledně jak je to ukázáno v předchozı́m přı́kladu.
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Třı́dy jsou definovány v souborech s přı́ponou .cls, balı́čky v souborech s přı́-
ponou .sty. Najdeme je obvykle v adresáři, kde je TEX nainstalován, a to v podadre-
sáři ...\tex\latex\název třı́dy či balı́čku. Dokumentace k těmto souborům
bývá pak v adresáři ...\doc\latex\název třı́dy či balı́čku, většinou v .dvi
nebo .pdf souborech, někdy doprovázená soubory s přı́klady.

Na internetu (na [P19]) lze někdy sehnat novou třı́du nebo balı́ček, přı́padně
novou verzi. Při instalaci postupujeme podle pokynů v souboru dodávaném s třı́-
dou nebo balı́čkem, obvykle jde jen o to v adresáři ...\tex\latex vytvořit vhodně
pojmenovaný adresář, do něho zkopı́rovat několik souborů a pak obnovit databázi.

O jakou databázi vlastně jde? TEX se skládá ze spousty velmi malých souborů.
Aby ho časté přistupovánı́ k těmto souborům zbytečně nezdržovalo (předevšı́m jejich
hledánı́ na disku), udržuje si jejich databázi, kde má uloženy veškeré potřebné infor-
mace, které mohou urychlit přı́stup k použı́vaným souborům. To značně zrychluje
práci, ale vedlejšı́m efektem je, že když provedeme změny ve struktuře těchto sou-
borů (včetně přidánı́ nového balı́čku), musı́me o tom TEXu „dát vědět“. U MiKTEXu
ve Windows se to dělá v menu START pomocı́ START → MiKTeX → MiKTeX Options,
tlačı́tko Refresh Now.

Úlohy:

1. Zjistěte, ve kterém adresáři (složce) je na vašem počı́tači nainstalován TEX,
a kde jsou soubory s třı́dami, balı́čky a jejich dokumentacı́. Nezapomeňte, že
samotný operačnı́ systém se svou funkcı́ hledánı́ vám může ulehčit práci.

2. Srovnejte dokumentace k třı́dám jasthesis, adfathesis, scrreprt (je v ad-
resáři koma-script, v souboru scrguien.pdf) a octavo. Všechny tyto třı́dy
vyzkoušejte na jednoduchém dokumentu s nadpisy a textem.

3. Najděte dokumentaci k těmto balı́čkům:

(a) balı́ček clock, zjistěte, jak se vkládá obrázek hodin a jak se ovládá jeho
vzhled,

(b) balı́čky pro úpravu nadpisů – fncychap, sectsty, quotchap,

(c) balı́ček pro tvarovánı́ odstavců – shapepar.

4. Zjistěte, k čemu sloužı́ balı́čky parallel a qsm.

5. Najděte dokumenteci balı́čků pro prezentace beamer a prosper, u obou se po-
dı́vejte na přı́klady (u prospera bude nutné provést překlad LaTeX=>PS=>PDF).

2.6.3 Nadpisy

Na tom, pro jakou třı́du dokumentu jsme se rozhodli, závisı́ nejen vzhled výsledného
dokumentu a výchozı́ nastavenı́ vlastnostı́ (jednostranný, oboustranný apod.), ale
v některých přı́padech i přı́kazy, které máme k dispozici. Týká se to předevšı́m
nadpisů.
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Ve výpisu 2.15 je způsob vkládánı́ nadpisů prvnı́ch třı́ úrovnı́, a to v prv-
nı́m sloupci pro třı́du article, v druhém pro třı́dy report a book. Jak vidı́me,
article nepoužı́vá vůbec přı́kaz \chapter. Tento přı́kaz totiž generuje graficky ře-
šené, „zdobnějšı́ “ a nápadnějšı́ nadpisy prvnı́ úrovně, kde obvykle bývá nadpis sa-
motný na jiném řádku než čı́slo kapitoly, zatı́mco přı́kazy obsahujı́cı́ slovo section
generujı́ jednořádkové nadpisy s čı́slem a textem nadpisu.

Výpis č. 2.15

\section{Nadpis prvnı́ úrovně}

Text prvnı́ kapitoly článku.

\subsection{Nadpis druhé úrovně}

Text podkapitoly.

\subsubsection{Nadpis třetı́ úrovně}

atd.

\chapter{Nadpis prvnı́ úrovně}

Text prvnı́ kapitoly dokumentu.

\section{Nadpis druhé úrovně}

Text podkapitoly.

\subsection{Nadpis třetı́ úrovně}

atd.

Někdy je třeba vložit nečı́slovaný nadpis, at’ už kterékoliv úrovně (třeba pro
úvodnı́ kapitolu). To provedeme mı́rnou změnou přı́kazu pro vloženı́ nadpisu, a to
přidánı́m hvězdičky. Pro různé úrovně tedy použijeme přı́kazy:

\chapter*{Nadpis prvnı́ úrovně v report a book}

\section*{Nadpis druhé úrovně v report a book nebo prvnı́ v article}

atd. pro dalšı́ úrovně. Nečı́slované nadpisy se však nezahrnou do obsahu, ale i to
lze řešit přidánı́m přı́kazu pro přidánı́ položky obsahu – podle přı́kladu 2.6.

Přı́klad 2.6 Úvodnı́ kapitola má být nečı́slovaná, ale chceme ji v obsahu doku-
mentu. Vlevo je řešenı́ pro třı́du article, vpravo pro report a book:

Výpis č. 2.16

\section*{Úvod}
\addcontentsline{toc}{section}{Úvod}

text kapitoly článku

\chapter*{Úvod}
\addcontentsline{toc}{chapter}{Úvod}

text kapitoly rozsáhlejšı́ho dokumentu

V parametrech přı́kazu zkratka toc znamená Table of Contents, tedy obsah. Když
použijeme lof, vkládáme do seznamu obrázků (List of Figures), když použijeme
lot, vkládáme do seznamu tabulek (List of Tables). Dalšı́mi možnostmi ovlivňovánı́
dokumentových seznamů se budeme zabývat v kapitole 2.12.

Dokument může být členěn také na většı́ dı́ly než kapitoly. Když chceme shrnout
vı́ce kapitol do většı́ho celku, části, pak pro jednotlivé části použijeme „nadnadpis“
\part{Název části}.

Pro oddělenı́ přı́loh od běžných kapitol použijeme přı́kaz \appendix. Od tohoto
přı́kazu dále budou nadpisy nejvyššı́ úrovně čı́slovány velkými pı́smeny od „A“.
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Ve třı́dě book jsou k dispozici přı́kazy, které rozčlenı́ dokument na části lišı́cı́
se předevšı́m čı́slovánı́m stránek – \frontmatter, \mainmatter a \backmatter.
Způsob jejich použitı́ je naznačen ve výpisu 2.17.

Výpis č. 2.17
...
\begin{document}
\frontmatter % přednı́ část dokumentu
... titulnı́ strany, předmluva, obsah, seznam tabulek, apod.
\mainmatter % hlavnı́ část dokumentu
... běžné kapitoly dokumentu, čı́slované čı́sly
\appendix
... přı́lohy čı́slované pı́smeny, také patřı́ do hlavnı́ části dokumentu
\backmatter % koncová část dokumentu
... seznam literatury, rejstřı́k apod.

2.6.4 Titul a abstrakt

Už ve výpisu 2.1 na straně 39 jsme si mohli všimnout, že článek nemá jen název,
ale je uveden i autor, datum a abstrakt.

Název dokumentu, seznam autorů a datum jsou součástı́ titulu, některé typy
dokumentů do titulu řadı́ i jiné informace. Zatı́mco v přı́padě článku (třı́da article)
je titul jen jednou ze součástı́ prvnı́ strany, třı́dy report a book vytvářejı́ automa-
ticky celou titulnı́ stranu. Většinou použı́váme následujı́cı́ sekvenci přı́kazů:

Výpis č. 2.18

\title{Název dokumentu}
\author{Autor dokumentu} % Vı́ce autorů oddělı́me přı́kazem \and

\date{\today} % Když přı́kaz vynecháme, automaticky se doplnı́ skutečné datum,
% pokud přı́kaz použijeme, ale prázdný, datum nebude součástı́
% titulu vůbec

\maketitle

V editoru TEXnicCenter nemusı́me tyto přı́kazy vypisovat, můžeme použı́t menu
Insert → Document Title, kde Title Properties vložı́ přı́kazy pro název, autora a datum,
Title pak přı́kaz \maketitle.

Volbu Title Page využijeme, pokud chceme i ve třı́dě article mı́t celou titulnı́
stranu. Je to prostředı́, které má obsahovat přı́kazy vložené volbou Title Properties

a nahrazuje přı́kaz \maketitle.

Do parametrů uvedených přı́kazů nemusı́me vkládat pouze text, můžeme použı́t
přı́kazy pro jinou velikost pı́sma, vkládat vı́ce řádků, použı́t různé řezy pı́sma či
dokonce barvy a obrázky (u těch je trochu problém s umı́stěnı́m).

V menu Insert→ Document Title najdeme i volbu Abstract k vloženı́ abstraktu (nebo
napı́šeme \begin{abstract} ...\end{abstract}). Ten následuje za titulem.

Když pı́šeme článek nebo dokument s použitı́m jiné než standardnı́ třı́dy, ob-
vykle s touto třı́dou máme k dispozici jakýsi „návod k použitı́ “, což je dokument
psaný s použitı́m této třı́dy a popisuje jejı́ možnosti a způsob, jak je využı́vat. V ka-
pitole 2.6.2 je o této problematice vı́ce.
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2.6.5 Poznámky pod čarou a na okraj

Občas potřebujeme vložit do textu poznámku pod čarou. Ta se vkládá přı́kazem

\footnote{Text poznámky pod čarou.}

Před tı́mto přı́kazem obvykle nebývá mezera (znak poznámky pod čarou musı́ přilé-
hat k tomu, co komentujeme), v poznámce pı́šeme „celými větami“, tedy ještě před
ukončujı́cı́ závorkou bývá tečka či jiné interpunkčnı́ znaménko, a to i v přı́padě, že
je i za závorkou.

Poznámka na okraj se vytvořı́ přı́kazemPoznám-
ka na
okraj. \marginpar[text pro levý okraj]{text pro (pravý) okraj}

Text se vložı́ jako poznámka k pravému okraji textu u jednostranného dokumentu,
u oboustranného vždy na vnějšı́ stranu. Pokud zadáme i nepovinný parametr, tak
v přı́padě, že u oboustranného dokumentu vyjde poznámka vlevo, použije se text
(přı́padně s přı́kazy) z nepovinného parametru.

Poznámka je vždy zarovnána ke svému levému okraji, ale nic nám nebránı́
použı́t přı́kaz nebo prostředı́ pro zarovnánı́ doprava na levé stránce, jak je tomu
i ve výpisu 2.19 (poznámka vytvořená druhým odstavcem výpisu je u předchozı́ho
textu), přı́padně různé formátovacı́ přı́kazy.

Výpis č. 2.19

Poznámky pod čarou můžeme vložit téměř kdekoliv, napřı́klad tady\footnote{Toto je
poznámka pod čarou.}, mı́sto je označeno obvykle čı́slem. Poznámky na okraj
\marginpar[\raggedleft Toto je poznámka na okraj.]{Toto je poznámka na okraj.}
se objevı́ na okraji v~linii umı́stěnı́ tohoto přı́kazu.

V poznámce na okraj nemusı́ být jenom text, ale také obrázek nebo text různě
? upravený, napřı́klad\marginpar{\raisebox{-1em}{\fbox{\huge\bfseries ?}}}.

Poznámku na okraj nelze přı́mo použı́t uvnitř některých prostředı́, napřı́klad
v tabulkách nebo v prostředı́ minipage. Existuje však možnost, jak to obejı́t (je
použita napřı́klad v tabulce 2.3 na straně 52) – na mı́stě, kde chceme poznámku
vložit, napı́šeme mı́sto přı́kazu \footnote přı́kaz

\footnotemark

a hned za koncem daného prostředı́ (třeba tabulky nebo minipage) použijeme přı́kaz

\footnotetext{Text poznámky pod čarou.}

2.6.6 Záhlavı́ a zápatı́

Stránky dokumentu jsou obvykle čı́slovány, a pokud je vytvořena titulnı́ strana,
automaticky nenı́ čı́slována. Způsob čı́slovánı́ můžeme ovlivnit různými způsoby.
Jeden z nich jsme si už řekli – ve třı́dě book pomocı́ \frontmatter, \mainmatter
a \backmatter.
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Styl čı́slovánı́ úzce souvisı́ s definovánı́m záhlavı́ a zápatı́. Ve třı́dách article
a report je čı́slo stránky vždy v zápatı́ uprostřed, záhlavı́ je prázdné, ve třı́dě book je
v záhlavı́ čı́slo stránky a název kapitoly a na stránkách, kde začı́ná hlavnı́ kapitola,
je záhlavı́ prázdné a čı́slo stránky je v zápatı́ uprostřed.

Styl stránky včetně umı́stěnı́ čı́slovánı́ ovlivnı́me přı́kazy

\pagestyle{styl stránky}
\thispagestyle{styl stránky}

kde styl stránky může standardně být

• empty – záhlavı́ a zápatı́ jsou prázdné, stránky nejsou čı́slovány,

• plain – záhlavı́ je prázdné a v zápatı́ uprostřed je čı́slo stránky – výchozı́ pro
třı́dy article a report,

• headings – platı́ to, co bylo popsáno pro třı́du book,

• myheadings – můžeme do určité mı́ry určovat obsah záhlavı́ a zápatı́.

Prvnı́ přı́kaz bývá často v preambuli, ale může být kdekoliv v dokumentu, platı́
od stránky, na které je uveden. Druhý přı́kaz platı́ pouze pro stránku, na které je
uveden. Tyto přı́kazy nemajı́ vliv na hodnotu čı́sla stránky, jen na to, zda a kde je.

Pokud je nastaven styl myheadings, máme k dispozici přı́kazy pro změnu ob-
sahu záhlavı́:

\markright{pravá hlavička}
\markboth{levá hlavička}{pravá hlavička}

Prvnı́ přı́kaz se použı́vá pro jednostranné dokumenty, druhý pro oboustranné. Do
parametru můžeme napsat jakýkoliv text (třeba název dokumentu).

U těchto přı́kazů je nutno si dát pozor na začátek jejich platnosti. Záhlavı́ na levé

stránce je vygenerováno podle poslednı́ho použitı́ přı́kazu \markboth před začátkem
této stránky, zatı́mco záhlavı́ na pravé stránce podle prvnı́ho použitı́ \markboth nebo
\markright na této stránce.

Dalšı́ přı́kaz, tentokrát ovlivňujı́cı́ i hodnotu čı́sla, je

\pagenumbering{typ čı́slic}

Typ čı́slic může být arabic (běžné arabské čı́slice), roman (malé řı́mské čı́slice) nebo
Roman (velké řı́mské čı́slice).

Tento přı́kaz, jak je z parametru patrné, měnı́ typ čı́slic pro čı́slo stránky, platı́
od strany, na které je přı́kaz uveden. Pokaždé je čı́slo stránky vynulováno, tedy na
straně, kde je přı́kaz uveden, je vždy čı́slo 1, i nebo I (ne 0, protože čı́slo je vždy před
vloženı́m na stránku zvýšeno o 1).

Mnohem lepšı́ možnosti ovlivněnı́ tvaru záhlavı́ a zápatı́ máme s balı́čkem
fancyhdr. Použı́vá se stejně jako předdefinované styly stran, tedy po načtenı́ ba-
lı́čku přı́kazem \usepackage použijeme přı́kaz \pagestyle{fancy} a dále definu-
jeme záhlavı́ a zápatı́ přı́kazy z tabulky 2.5.

Parametr pozice u poslednı́ch dvou přı́kazů tabulky 2.5 se skládá ze dvou
pı́smen. Prvnı́ určuje, zda se obsah má vložit vlevo (L), doprostřed (C) nebo vpravo
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Jednostranný dokument:

\lhead{obsah}, \chead{obsah}, \rhead{obsah} levá, střednı́, pravá část záhlavı́
\lfoot{obsah}, \cfoot{obsah}, \rfoot{obsah} levá, střednı́, pravá část zápatı́

Oboustranný dokument:

\fancyhead[pozice]{obsah} obsah záhlavı́ na dané pozici
\fancyfoot[pozice]{obsah} obsah zápatı́ na dané pozici

Tabulka 2.5: Přı́kazy balı́čku fancyhdr

(R) na dané stránce, druhý udává, jestli se má přı́kaz použı́t pro liché (E – even) nebo
sudé (O – odd) stránky. Když chceme určit vı́ce různých dvojic, oddělı́me je čárkou.
Tedy pokud chceme mı́t na lichých stránkách v záhlavı́ vlevo název dokumentu
a v zápatı́ na sudých stránkách vlevo a lichých vpravo datum, použijeme přı́kazy

\fancyhead[LE]{Název našeho dokumentu}
\fancyfoot[LO,RE]{\today}

V parametrech přı́kazů můžeme také použı́t přı́kaz, který vygeneruje název hlavnı́
kapitoly (napı́šeme \leftmark), kapitoly druhé úrovně (\rightmark) nebo čı́slo
stránky (\thepage). Dále lze nastavit čáry oddělujı́cı́ záhlavı́ nebo zápatı́ od textové
části stránky (jejich výšku):

\renewcommand{\headrulewidth}{tloušt’ka}
\renewcommand{\footrulewidth}{tloušt’ka}

Přı́klad 2.7 Ukážeme si vytvořenı́ jednoduchého záhlavı́ a zápatı́ v jednostranném
(vlevo) a oboustranném (vpravo) dokumentu pomocı́ balı́čku fancyhdr.

Výpis č. 2.20
...
\pagestyle{empty}
... stránky bez čı́slovánı́
\pagestyle{fancy}
\pagenumbering{Roman}
\cfoot{}
\rhead{\thepage}
\lhead{}
\renewcommand{\headrulewidth}{0pt}
... obsah; řı́mské čı́slovánı́ stránek
\lhead{\leftmark}
\renewcommand{\headrulewidth}{.8pt}
\pagenumbering{arabic}
... stránky s arabským čı́slovánı́m

...
\pagestyle{empty}
... stránky bez čı́slovánı́
\pagestyle{fancy}
\pagenumbering{Roman}
\fancyfoot[CE,CO]{}
\fancyhead[LO,RE]{\thepage}
\fancyhead[LE,RO]{}
\renewcommand{\headrulewidth}{0pt}
... obsah; řı́mské čı́slovánı́ stránek
\fancyhead[LE]{\leftmark}
\fancyhead[RO]{\rightmark}
\renewcommand{\headrulewidth}{.8pt}
\pagenumbering{arabic}
... stránky s arabským čı́slovánı́m
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2.6.7 Dlouhé dokumenty

Samotnému TEXu, LATEXu a ani programům zobrazujı́cı́m DVI, PS a PDF soubory
obvykle dlouhé dokumenty nečinı́ žádné problémy. Přesto však předevšı́m pro pře-
hlednost, snadnějšı́ orientaci a také pro zjednodušenı́ práce s editorem je vhodné
velmi dlouhý zdrojový soubor rozdělit do vı́ce souborů.

Všechny soubory, které takto vytvořı́me, budou mı́t přı́ponu TEX a měly by
být ve stejném adresáři (složce). Jeden ze souborů bude hlavnı́. V něm je dána
struktura celého dokumentu včetně preambule, titulnı́ch stran, obsahu apod., tedy
styl dokumentu určujeme právě zde. Tento soubor pojmenujeme tak, jak chceme
mı́t pojmenovaný i výsledný dokument (kromě přı́pony, samozřejmě).

Jednotlivé části (třeba kapitoly) uložı́me do vhodně pojmenovaných souborů
s přı́ponou TEX a vložı́me do hlavnı́ho dokumentu pomocı́ některého z těchto přı́-
kazů:

\input{soubor}
\include{soubor}

V obou přı́padech pı́šeme název souboru bez přı́pony. Prvnı́ z těchto dvou přı́kazů
vlastně jen provede při každém překladu „vkopı́rovánı́ “ vkládaného souboru do toho,
kde je přı́kaz uveden, druhý před a po tomto přenesenı́ navı́c vložı́ stránkový zlom
(tedy se přejde na novou stránku). Při vkládánı́ celých kapitol, které majı́ začı́nat
na nové stránce, proto použı́váme přı́kaz \include, jindy přı́kaz \input. Když po-
třebujeme stránkový zlom před souborem, ale ne za nı́m, vložı́me soubor přı́kazem
\input a před nı́m použijeme třeba přı́kaz \newpage.

Přı́klad 2.8 Ve výpisu 2.21 vidı́me možný tvar hlavnı́ho souboru chaloupka.tex.
Vkládané soubory nemusı́ mı́t žádnou zvláštnı́ strukturu, obvykle začı́najı́ přı́kazem
\chapter.

Výpis č. 2.21

\documentclass[11pt,a4paper]{report}
\usepackage{czech,a4wide}

\title{Pernı́ková chaloupka\\[1em] Možný postup konstrukce}
\author{Jan Novák}
\date{\itshape Poslednı́ aktualizace: \today}

\begin{document}
\maketitle
\tableofcontents % vloženı́ obsahu

\include{uvod} % vložen soubor uvod.tex, nečı́slovaná kapitola Úvod
\include{material} % vložen soubor material.tex s kapitolou Použitý materiál
\newpage\input{konstrukce1}

% soubor konstrukce1.tex s prvnı́ částı́ kapitoly Postup konstrukce
\input{konstrukce2} % soubor konstrukce2.tex, druhá část kapitoly
\include{statika} % vložen soubor statika.tex, kapitola Statika objektu
\include{limitypouziti} % limitypouziti.tex, kapitola Limity použitı́ konstrukce

\appendix % následujı́ přı́lohy:
\include{prilohaopohadce} % prilohaopohadce.tex, prvnı́ přı́loha
\include{konstrukcninakresy} % konstrukcninakresy.tex, druhá přı́loha
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\include{zaver} % vložen soubor zaver.tex, nečı́slovaná kapitola Závěr
\include{literatura}

% literatura.tex, nečı́slovaná kapitola se seznamem literatury
\end{document}

Překládáme vždy jen hlavnı́ dokument, tedy napřı́klad v editoru TEXnicCenter
bychom se měli před každým překladem přesunout ze souboru, se kterým pracu-
jeme (a také ho uložit), do hlavnı́ho souboru a pak teprve spustit překlad. Tento
postup nám zjednodušuje možnost práce s projekty, kterou nabı́zı́ mnoho editorů
určených pro práci s TEXem a LATEXem. Bohužel v každém editoru se s projekty
pracuje trochu jinak, včetně přı́pon pomocných souborů projektu.

TEXnicCenter ukládá informace o projektu do pomocných souborů pojmenova-
ných stejně jako hlavnı́ soubor, a to s přı́ponou TCP (nastavenı́ editoru, jako je verze,
jazyk, naposledy použitý profil pro překlad, název hlavnı́ho souboru apod.) a TPS
(které soubory jsou právě otevřené–rozpracované, velikost a pozice oken těchto sou-
borů, pozice kurzoru v souboru apod.). Oba soubory jsou textové, tedy je můžeme
otevřı́t třeba v Poznámkovém bloku.

Do těchto souborů se ukládajı́ data při každém uzavřenı́ projektu. Projekt ote-
vřeme jednoduše tak, že poklepeme na soubor TCP a zı́skáme stejné pracovnı́ pro-
středı́ jako při poslednı́m ukončenı́ práce.

Překlad projektu se provádı́ jiným tlačı́tkem a klávesovou zkratkou než v přı́-
padě jednoho dokumentu – použı́váme tlačı́tko nebo klávesovou zkratku F7 .
Máme také k dispozici strukturu objektu, seznam souborů a seznam objektů v okně
Navigator, které si zobrazı́me přes menu View → Navigator Bar.

Nový projekt vytvořı́me (v editoru TEXnicCenter) přes menu File → New project

a existujı́cı́ otevřeme přes File → Open project nebo v přı́padě, že jsme s nı́m na
tomto počı́tači už pracovali, rychlejšı́ cestou přes File → Recent Projects. Může se
také hodit možnost rychle bez hledánı́ otevřı́t hlavnı́ soubor projektu, pokud tak
editor neučinil, a to přes Project → Open main file.

Projekt lze vytvořit i dodatečně, stačı́ v menu editoru zvolit Project→ Create with

active file as main file.

2.7 Vı́cesloupcová sazba

Někdy se může hodit možnost sazby do vı́ce sloupců, zúženı́ odstavce nebo do-
konce naskládánı́ několika takových odstavců vedle sebe (jeden z postupů je využit
i v tomto dokumentu pro umı́stěnı́ výpisu zdrojového textu a výsledku vedle sebe).

Pro vı́cesloupcovou sazbu nebo skládánı́ bloků textu třeba i vedle sebe jsou
v TEXu tyto možnosti:

1. Při určenı́ třı́dy dokumentu použijeme také parametr twocolumn, napřı́klad:

\documentclass[a4paper,12pt,twocolumn]{article}
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Pak se sice titul dokumentu vysázı́ „jednosloupcově“, ale text dokumentu bude
ve dvou sloupcı́ch. Tento způsob nenı́ použitelný, pokud chceme v dokumentu
měnit dvousloupcovou a jednosloupcovou sazbu nebo použı́vat vı́ce než dva
sloupce.

2. Použijeme balı́ček multicol, ve kterém je definováno prostředı́ multicols,
tedy do hlavičky dokumentu umı́stı́me přı́kaz pro načtenı́ balı́čku

\usepackage{multicol}

a text, který chceme zformátovat do vı́ce sloupců, uzavřeme do prostředı́:

\begin{multicols}{počet sloupců} text \end{multicols}

Napřı́klad pro tři sloupce:

\begin{multicols}{3}
text, který chceme mı́t ve vı́ce sloupcı́ch
\end{multicols}

Všechny sloupce budou mı́st stejnou šı́řku.

3. Text nebo jiné objekty umı́stı́me do přı́kazu parbox, který se použı́vá násle-
dovně:

\parbox[zarovnánı́ od předchozı́ho]{šı́řka}{text nebo něco jiného}

Nepovinných parametrů je ve skutečnosti vı́ce než jeden (dokonce i výška par-
boxu), podrobnosti viz nápověda nebo [T31]. V nepovinném parametru, který
zde máme uveden, můžeme zadat některé z pı́smen t, b, c (top, bottom,
center) pro vertikálnı́ pozici celého boxu vzhledem k okolnı́mu textu.

4. Podobně se použı́vá prostředı́ minipage:

\begin{minipage}[zarovnánı́ od předchozı́ho]{šı́řka}
text nebo něco jiného
\end{minipage}

Šı́řku můžeme udat v běžných jednotkách, ale protože se obvykle vztahuje
k šı́řce stránky (tu vracı́ přı́kaz \textwidth), často se použı́vá údaj, který se odvı́jı́
právě od šı́řky stránky. Napřı́klad pokud chceme zadat o něco méně než polovinu
stránky, napı́šeme jako šı́řku údaj .49\textwidth a automaticky se šı́řka parboxu
nastavı́ na 0,49-násobek šı́řky stránky7.

Při skládánı́ parboxů a prostředı́ minipage je můžeme sázet přı́mo vedle sebe
nebo oddělovat jinými objekty (třeba přı́kazem \rule s některým parametrem nu-
lovým, přı́kazem \hfill nebo jiným parboxem).

Přı́klad 2.9 Ukážeme si použitı́ prostředı́ multicols, přı́kazu parbox a prostředı́
minipage. parbox a minipage ohraničı́me rámečkem (přı́kaz \fbox), abychom vi-
děli skutečnou zabranou šı́řku. Použijeme také přı́kaz \rule, který vykreslı́ obdélnı́k

7Všimněte si, že mezi reálným čı́slem .49 (tedy 0,49) a přı́kazem \textwidth se sice symbol pro
násobenı́ nepı́še, ale vyhodnocuje se zde.
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(v prvnı́m přı́padě o nulové výšce a pak o výšce dva body), jeho účelem je oddálit od
sebe předchozı́ a následujı́cı́ objekty o zadanou „šı́řku“. Druhý má výšku nenulovou,
abychom viděli skutečnou pozici obdélnı́ku.

Výpis č. 2.22

\begin{multicols}{2}
Toto je text, který bude zarovnán do dvou sloupců, protože v~parametru prostředı́
\texttt{multicols} je čı́slo 2. Kdyby tam bylo třeba čı́slo 4, tak by byl text
zarovnaný do čtyř sloupců. V~tomto prostředı́ mohou být trochu problémy třeba
s~popisky obrázků nebo poznámkami pod čarou.
\end{multicols}

\noindent
\fbox{ % všimněte si odsazenı́ dalšı́ho textu zleva - pro přehlednost

\parbox{.45\textwidth}{
Toto je obsah prvnı́ho boxu o šı́řce 0,45-násobku šı́řky textu na stránce.
}

}
\rule{1ex}{0pt} % tento obdélnı́k nebude vidět
\fbox{

\parbox{.5\textwidth}{
Toto je obsah druhého boxu širokého polovinu šı́řky textu na stránce.
}

}

\noindent
\fbox{

\begin{minipage}{.45\textwidth}
Toto je obsah prvnı́ho boxu o šı́řce 0,45-násobku šı́řky textu na stránce.
\end{minipage}

}
\rule{1ex}{2pt} % tento obdélnı́k bude vidět
\fbox{

\begin{minipage}{.5\textwidth}
Toto je obsah druhého boxu širokého polovinu šı́řky textu na stránce.
\end{minipage}

}

Zde vidı́me výsledek předchozı́ho kódu:

Toto je text, který bude zarovnán do
dvou sloupců, protože v parametru pro-
středı́ multicols je čı́slo 2. Kdyby tam
bylo třeba čı́slo 4, tak by byl text zarov-

naný do čtyř sloupců. V tomto prostředı́
mohou být trochu problémy třeba s po-
pisky obrázků nebo poznámkami pod ča-
rou.

Toto je obsah prvnı́ho boxu o šı́řce
0,45-násobku šı́řky textu na stránce.

Toto je obsah druhého boxu širokého po-
lovinu šı́řky textu na stránce.

Toto je obsah prvnı́ho boxu o šı́řce
0,45-násobku šı́řky textu na stránce.

Toto je obsah druhého boxu širokého po-
lovinu šı́řky textu na stránce.
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2.8 Křı́žové odkazy

Křı́žové odkazy se dělajı́ velice jednoduše a rychle. Zde si ukážeme, jak se vytvářejı́
odkazy na kapitolu nebo konkrétnı́ mı́sto v dokumentu (čı́slo strany), a také na
čı́slované prostředı́, které jsme vytvořili pomocı́ přı́kazu \newtheorem.

Odkaz na položku čı́slovaného seznamu jsme viděli v kapitole 2.4 na straně 55,
odkazy na obrázek a tabulku probereme v kapitole 2.10.5.

Při práci s odkazy se může objevit jedno nebo i vı́ce varovných hlášenı́ (LaTeX
Warning: Reference ‘nejakyodkaz’ on page xx undefined ...). Toho si nemusı́me
všı́mat, protože když si označı́me mı́sto, na které chceme odkazovat, je zaregistro-
váno až při překladu samotném, ale při adresovánı́ odkazu LATEX vycházı́ z informacı́
zı́skaných při předchozı́m překladu. Tedy při objevenı́ varovných hlášenı́ vztahujı́-
cı́ch se k odkazům prostě znovu přeložı́me. Pokud se varovná hlášenı́ objevujı́ dále,
je v názvu odkazu překlep.

Mı́sto v dokumentu (záložku) pro jakýkoliv typ odkazu označı́me přı́kazem

\label{nazev}

kde nazev je název označeného mı́sta, který budeme v různých odkazech použı́vat.
Nepoužı́váme v něm českou diakritiku (tedy pı́šeme „cesky“), ani mezery, tečky či
většinu dalšı́ch oddělovačů. Naopak velmi často se v názvu objevuje dvojtečka jako
užitečný oddělovač zkratky pro typ odkazu a zbytku názvu. Napřı́klad

\label{kap:obsluhaprogramu},
\label{obr:obsluhaprogramu},

\label{tab:obsluhaprogramu},
\label{popis:obsluhaprogramu}

jsou různá mı́sta v dokumentu (začátek kapitoly, obrázek, tabulka, popis), u kte-
rých nám fantazie či spoléhánı́ na vlastnı́ pamět’ nestačily na různé názvy, ale pro
přehlednost jsou odlišena jakousi předponou. Nenı́ to nutné, ale je to praktické
a přehledné. Netřeba připomı́nat, že každý název musı́ být jedinečný – kdyby dvě
mı́sta byla pojmenovaná stejně, vznikl by jistý chaos při rozhodovánı́, na které z nich
se vlastně daným názvem odkázat.

Pokud chceme zı́skat čı́slo kapitoly, ve které se nacházı́ určité pojmenované
mı́sto, použijeme přı́kaz

\ref{nazev}

kde nazev je název pojmenovaného mı́sta v přı́kazu \label. Pojmenované mı́sto se
může nacházet kdekoliv v kapitole, jen ne uvnitř prostředı́, kde jsou čı́tače, na které
se dá také odkazovat (třeba čı́selný seznam nebo prostředı́ označovaná čı́sly, jako je
třeba v tomto dokumentu prostředı́ pro přı́klady nebo výpisy kódu).

Čı́slo stránky, na které se pojmenované mı́sto nacházı́, dostaneme přı́kazem

\pageref{nazev}

Význam je tentýž jako u přı́kazu \ref. Oba přı́kazy můžeme kombinovat, což se
hodı́ zejména, pokud pojmenované mı́sto a odkaz jsou na různých stránkách:

. . . je v kapitole \ref{nazev} na straně \pageref{nazev}



KAPITOLA 2 TYPOGRAFICKÝ SYSTÉM TEX 70

Odkazy na prostředı́ označené čı́slem se dělajı́ úplně stejně – za začátek prostředı́
umı́stı́me přı́kaz \label a pro odkaz použijeme přı́kaz \ref, přı́padně \pageref.

Přı́klad 2.10 Pokud je v preambuli dokumentu definováno prostředı́ priklad jako
na začátku výpisu 2.23, můžeme se na ně jednoduše odkazovat podle textu dále.

Výpis č. 2.23

\newtheorem{tpriklad}{Přı́klad}[chapter]
% (ve třı́dě article by mı́sto chapter bylo section)
\newenvironment{priklad}%

{\begin{tpriklad}\rule{1pt}{0pt}\normalfont}%
{\end{tpriklad}}

...
\label{kap:vytvoreniodkazu}
...
\begin{priklad}\label{pri:vytvoreniodkazu}
text nějakého přı́kladu
\end{priklad}
...
V~přı́kladu \ref{pri:vytvoreniodkazu} na straně
\pageref{pri:vytvoreniodkazu} v~kapitole
\ref{kap:vytvoreniodkazu} jsme mohli vidět, že ...

Přı́klad 2.10 text něja-
kého přı́kladu

. . .

V přı́kladu 2.10 na stra-
ně 70 v kapitole 2.8 jsme
mohli vidět, že . . .

2.9 Jak na chyby

Snadnost nalezenı́ chyb taky trochu závisı́ na editoru, který použı́váme. Po přeloženı́
LATEX vytvářı́ soubor s přı́ponou LOG, ve kterém jsou uvedeny veškeré informace
o překladu včetně určenı́ chyb. Tento soubor většina editorů přı́mo určených přı́mo
pro LATEX zobrazı́ v okně nebo v podokně, v přı́padě programu TEXnicCenter jde
o oblast u spodnı́ho okraje okna. Dovı́me se zde předevšı́m, zda jsou v dokumentu
chyby, varovánı́ a přesahy:

• chyba (Error) je takové selhánı́, které (většinou) znemožnı́ vytvořit výsledný
soubor, třeba překlep v přı́kazu, u začátečnı́ků je častou chybou „připojenı́ “
přı́kazu bez parametrů k následujı́cı́mu slovu (napřı́klad \largenějakéslovo),

• varovánı́ (Warning) je „menšı́“ selhánı́, které obvykle nezabránı́ vytvořenı́ vý-
sledného souboru, ale „něco nenı́ v pořádku“; často se jedná o použitı́ přı́kazu
na nevhodném mı́stě (třeba přı́kaz pro matematický režim se objevı́ mimo ma-
tematická prostředı́) nebo chybějı́cı́ řez pro použı́vaný font, tyto problémy LATEX
sám obvykle nějak vyřešı́ (provede náhradu nebo mı́sto objektu vytvořı́ prázdné
mı́sto),

• přesah (Bad Box, vadný box) vzniká přesáhnutı́m objektu (včetně textu) tam,
kde už nemá co dělat; jde většinou o slova, která se nedařı́ rozdělit na konci
řádku tak, aby mezery mezi slovy zůstaly opticky vhodně malé či velké, ostatně
přesáhnutı́ okraje stránky o milimetr většina lidı́ ani nepostřehne.
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Chyby bychom měli rozhodně řešit, jen málokterá je zcela nedůležitá. Varovánı́
a přesahy je doporučeno řešit, ale nenı́ to už tak bezpodmı́nečně nutné. Některá
varovánı́ a přesahy se obvykle neřešı́ nebo je řešenı́ triviálnı́:

• varovánı́ „There were undefined references.“ a „Label(s) may have changed
. . . “ se objevı́ vždy, když použijete přı́kaz pro pojmenovánı́ mı́sta v dokumentu
a přı́padně toto pojmenovánı́ hned použijete pro křı́žový odkaz; stačı́ znovu
provést překlad a tato varovánı́ zmizı́ (pokud nezmizı́, máme bud’v pojmenovánı́
nebo v křı́žovém odkazu překlep),

• varovánı́ „LaTeX Font Warning: Font shape . . . not available . . . “ se někdy
objevuje, pokud nastavı́me jiný než standardnı́ font a chceme v něm použı́vat
řezy (některé fonty nejsou pro určité řezy definovány); tento problém LATEX
vyřešı́ přesně tak, jak pı́še dále v chybovém hlášenı́ – na daném mı́stě použije
jiný (podobný) řez,

• hlášenı́ o přesahu „Underfull \hbox . . . “ znamená většinou problém s rozděle-
nı́m slova; můžeme pomoci bud’ přı́kazem \hyphenation (viz nápověda), kde
jako parametr použijeme problémová slova s naznačenı́m možnosti rozdělenı́
(na mı́stech, kde lze slovo rozdělit, vložı́me spojovnı́k -, slova oddělujeme me-
zerou), nebo jednodušeji přı́mo ve slově, které vyvolává hlášenı́, na vhodném
mı́stě rozdělenı́ vložı́me dvojznak \- (napřı́klad větši\-nu) – na konci řádku
se slovo rozdělı́, ale kdyby se náhodou posunulo dál od konce řádku, spojovnı́k
se nevypı́še,

• při použitı́ některých balı́čků občas dostáváme varovánı́ a hlášenı́ o vadných
boxech, i když je vı́ceméně všechno v pořádku; je to většinou způsobeno ne-
konzistentnostmi mezi balı́čky, obvykle si těchto problémů nemusı́me všı́mat.

Zvláště pokud je problémů vı́ce, hodı́ se možnost pohybu mezi nimi. U programu
TEXnicCenter najdeme tlačı́tka na hornı́m panelu nástrojů napravo od „překláda-
cı́ch tlačı́tek“ – . Klepánı́m na tato tlačı́tka se pohybujeme ve zdrojovém
souboru mezi chybami, varovánı́mi a přesahy a opravujeme. Prvnı́ dvě tlačı́tka nás
v dokumentu přesouvajı́ mezi chybami, dalšı́ dvě mezi varovánı́mi a poslednı́ dvě
mezi přesahy.

Tı́mto způsobem se dostaneme vždy k odstavci, ve kterém je chyba, ne přı́mo ke
konkrétnı́mu řádku. Najı́t konkrétnı́ mı́sto chyby nám pomůže výpis již zmı́něného
LOG souboru, ve kterém se přesouváme automaticky zároveň s přesouvánı́m mezi
chybami ve zdrojovém souboru.

2.10 Oživenı́ textu

2.10.1 Vkládané obrázky

Pro vkládánı́ již hotových obrázků jsou v LATEXu dvě základnı́ možnosti. Prvnı́, pou-
žitı́ balı́čku graphics, je považována za jednoduššı́, ale jsme omezeni na vkládánı́
obrázků s přı́ponou PS a EPS při překladu přes formát PS a na obrázky s přı́ponou
PDF při překladu přı́mo do PDF. Druhou možnostı́ je balı́ček graphicx, kde můžeme
při překladu přı́mo do PDF vkládat kromě jiného také obrázky s přı́ponou JPG a PNG.
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Nejdřı́v se podı́váme na balı́ček graphics. Načı́tá se s nepovinným argumentem
určujı́cı́m typ překladu. Pokud překládáme nejdřı́v do formátu PS a pak do PDF
(v TEXnicCenter LaTeX=>PS=>PDF), bude přı́kaz pro načtenı́ vypadat takto:

\usepackage[dvips]{graphics}

Při překladu přı́mo do PDF (v TEXnicCenter LaTeX=>PDF) použijeme jako parametr
pdftex8.

Hotový obrázek vložı́me do dokumentu přı́kazem

\includegraphics{název souboru}
\includegraphics*[x1,y1][x2,y2]{název souboru}

Druhý tvar přı́kazu umožnı́ vložit do dokumentu pouze výřez obrázku (zadáme
nejdřı́v souřadnice levého dolnı́ho rohu a pak pravého hornı́ho rohu v souřadni-
cı́ch původnı́ho obrázku, počátek soustavy je vlevo dole).

Přı́kaz Význam

\rotatebox{úhel}{objekt} otočı́ objekt o zadaný úhel
\scalebox{hnásobek}[vnásobek]{objekt} roztázne objekt dle násobků
\resizebox{šı́řka}{výška}{objekt} roztáhne objekt na zadané rozměry

Tabulka 2.6: Dalšı́ přı́kazy balı́čku graphics

Prvnı́ přı́kaz v tabulce 2.6 otočı́ objekt (cokoliv – text nebo třeba obrázek vlo-
žený pomocı́ \includegraphics) o zadaný úhel ve stupnı́ch. Druhý a třetı́ přı́kaz
roztázne nebo smrštı́ objekt podle zadaných parametrů.

V přı́kazu \scalebox zadáváme násobnost, kdežto v přı́kazu \resizebox cı́lové
rozměry. Parametr vnásobek je nepovinný, když ho neudáme, použije se i pro verti-
kálnı́ násobnost také parametr hnásobek (tedy poměry stran zůstanou zachovány).

U přı́kazu \resizebox může být jednı́m z parametrů šı́řka a výška symbol !.
Tento parametr se dopočı́tá tak, aby si obrázek zachoval poměry stran.

Přı́klad 2.11 Na výpisu 2.24 vidı́me způsob použitı́ výše uvedených přı́kazů. Ob-
rázek je nejdřı́v vložen bez jakýchkoliv úprav a potom pozměněn zadánı́m výřezu
a přı́kazy \rotatebox, \scalebox a \resizebox. Potom je přı́kaz \rotatebox po-
užit na běžný text. Abychom mohli pracovat s vı́ce řádky najednou, je text vložen
v přı́kazu \parbox. Obrázky jsou odděleny přı́kazem \hfill, aby byly rovnoměrně
rozloženy na celou šı́řku stránky.

Výpis č. 2.24

\includegraphics{obr/slunecnice.eps} \hfill
\includegraphics*[10,0][80,100]{obr/slunecnice.eps} \hfill
\rotatebox{15}{\includegraphics*[30,30][80,70]{obr/slunecnice.eps}} \hfill
\scalebox{.5}{\includegraphics{obr/slunecnice.eps}} \hfill
\resizebox{5em}{!}{\includegraphics{obr/slunecnice.eps}} \hfill
\rotatebox{90}{\parbox{8em}{\large\itshape Obrázek\\slunečnice}}

8Parametr nemusı́me uvádět, pokud ho napı́šeme jako jeden z nepovinných parametrů přı́kazu
\documentclass, napřı́klad: \documentclass[dvips,11pt,a4paper]{article}.
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rá
z
e
k

s
lu

n
e
č
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V přı́kladu 2.11 jsme si mohli všimnout, že náš obrázek je uložen v adresáři
(složce) obr, který se pak nacházı́ v tom adresáři, kde je překládaný soubor s přı́-
ponou TEX.

Jak bylo výše naznačeno, přı́pona souboru s obrázkem musı́ být PS nebo EPS
při překladu přes formát PS, a nebo PDF při překladu přı́mo do formátu PDF. .
Konverzi můžeme provést v běžných lepšı́ch grafických editorech, pokud je máme
k dispozici (jsou obvykle dost drahé), nebo pomocı́ některého z volně dostupných
programů ImageMagick9 a Gimp10.

Gimp má grafické prostředı́, tedy rozhodně nenı́ problém konverzi provést, ale je
hodně rozsáhlý (také mı́stem, které zabere na disku) a je považován za snadno do-
stupný ekvivalent Adobe Photoshopu. ImageMagick je souhrn malých nenáročných
programů, pro konverzi budeme použı́vat program convert. Konverze do formátu
EPS probı́há takto:

convert původnı́soubor.přı́pona novýsoubor.eps

Obrázek, se kterým jsme pracovali na straně 73, měl původně přı́ponu JPG.
Proto bylo třeba ho převést do EPS takto:

convert slunecnice.jpg slunecnice.eps

Pokud mı́sto balı́čku graphics použijeme balı́ček graphicx, zı́skáme některé
dalšı́ možnosti (napřı́klad u otáčenı́ lze kterýkoliv bod obrázku zvolit za střed otá-
čenı́), tvar parametrů je trochu jiný, navı́c při překladu přı́mo do pdf máme většı́
svobodu volby přı́pony souboru. Balı́ček se načı́tá stejným způsobem (tj. obvykle
zadáváme dvips nebo pdftex).

Nejdůležitějšı́m přı́kazem balı́čku je přı́kaz obdobný předchozı́mu, jen parame-
try jsou trochu jiné:

\includegraphics[parametry oddělené čárkou]{soubor.přı́pona}
\includegraphics*[parametry oddělené čárkou]{soubor.přı́pona}

9Program ImageMagick zvládá nejrůznějšı́ úpravy (nejen) obrázků. Zı́skáme ho napřı́klad na ad-
rese http://www.imagemagick.org/script/binary-releases.php, vybereme variantu pro Linux
nebo Windows, pro Windows raději statickou variantu. Na uvedených WWW stránkách je také návod
k instalaci a použitı́.

10České stránky programu Gimp včetně nejrůznějšı́ch užitečných informacı́ najdeme napřı́klad na
stránkách http://www.gimp.cz/, při stahovánı́ volı́me raději stabilnı́ verzi.

http://www.imagemagick.org/script/binary-releases.php
http://www.gimp.cz/
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V seznamu parametrů oddělených čárkami se pı́še vždy název parametru následo-
vaný rovnı́tkem a hodnotou. Jako parametry můžeme použı́t:

• výřez obrázku, který se má vložit, zadáváme postupně čtyři čı́sla – souřadnice
levého dolnı́ho rohu a pak pravého hornı́ho rohu; formát je trochu jiný než
u předchozı́ho: bb= x levý y dolnı́ x pravý y hornı́, pro správnou funkci
tohoto parametru použijeme variantu přı́kazu s hvěhdičkou,

• úhel otočenı́ ve stupnı́ch: angle=stupně,

• šı́řka (obrázek se roztáhne nebo smrštı́), musı́me zadat i jednotku (pt, cm, atd.):
width=šı́řka,

• výška (podobně jako šı́řka): height=výška,

• zvětšenı́ nebo zmenšenı́ obrázku: scale=poměr (výchozı́ hodnota je 1, tedy
zadáváme násobnost původnı́ velikosti),

• atd. (viz dokumentace balı́čku graphicx).

Napřı́klad:

\includegraphics*[bb=10 0 80 100,scale=0.75]{slunecnice.eps}

V balı́čku najdeme i dalšı́ přı́kazy – \rotatebox, \scalebox, atd. Tyto přı́kazy
majı́ podobný význam jako stejně pojmenované přı́kazy v balı́čku graphics, ale
parametry jsou trochu jiné a také máme k dispozici vı́ce možnostı́ nastavovánı́
vlastnostı́ zpracovávaných objektů.

2.10.2 Nákresy

Pro vytvářenı́ jednoduchých grafických objektů použı́váme prostředı́ picture. Po-
užı́vá se s udánı́m rozměrů „plátna“, které (trochu nezvykle) pı́šeme do kulatých

závorek jako parametr prostředı́, a to bez udánı́ jednotky (standardně je jednotkou
typografický bod).

\begin{picture}(šı́řka,výška)
...
\end{picture}

Dovnitř prostředı́ pı́šeme přı́kazy vykreslujı́cı́ jednotlivé objekty (rámečky, čáry–
úsečky, vektory, kružnice, ovály, atd.). Každý objekt musı́me umı́stit na určitou
pozici přı́kazem

\put(x,y){objekt}

kde x a y jsou souřadnice, na které chceme objekt umı́stit. Bod (0,0) je v levém
dolnı́m rohu.

Dvojčı́slı́ v kulatých závorkách se použı́vá také v některých přı́kazech pro kres-
lenı́ objektů. Někde znamená rozměry (šı́řku a výšku) objektu, jako třeba u rámečků
(přı́kazy \framebox, \dashbox a \makebox), u oválů (přı́kaz \oval) délky vodorovné
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a svislé osy, jindy zase určenı́ úhlu sklonu, a to pro čáry a vektory (přı́kazy \line
a \vector).

Čı́sla pro úhel sklonu a parametr pro výpočet délky čáry a vektoru se určujı́
podle obrázku 2.7. Čı́sla a a b musı́ být celá čı́sla z intervalu < −6, 6 > u čar
a z intervalu < −4, 4 > u vektorů. Různými kombinacemi těchto čı́sel dosáhneme
různých sklonů.

Můžeme si všimnout, že nezadáváme přı́mo délku (kromě svislé čáry či vektoru,
tam ano), ale délku průmětu na osu x.

(x,y)
��������*

︷ ︸︸ ︷
a

︷
︸
︸
︷

b ︷

︸︸

︷

délka

︸ ︷︷ ︸

průmět

\put(x,y){\vector(a,b){průmět}}

Obrázek 2.7: Určenı́ sklonu čáry a vektoru

Přı́klad 2.12 Ukážeme si použitı́ prostředı́ picture a vkládánı́ různých typů
objektů. Vysvětlenı́ parametrů přı́kazů najdeme v tabulkách 2.7, 2.8 a 2.9 od
strany 76. V přı́kazech si všimněte, kdy se u čı́sla udává jednotka.

Výpis č. 2.25

\begin{picture}(160,150)
\put(0,0){\framebox(160,150){}}
\put(5,5){\dashbox{3}(150,140){}}
\put(10,10){\small Jeden řádek.}
\put(10,20){\makebox(60,10){\small Jeden řádek.}}
\put(75,10){\framebox(68,28)%

{\parbox{58pt}{\small Přı́padně vı́ce řádků.}}}

\put(10,40){\line(0,1){50}}
\put(10,40){\line(1,0){50}}
\put(10,40){\line(1,1){50}}
\put(10,40){\line(1,2){50}}
\put(10,40){\line(2,1){50}}

\put(60,50){\vector(1,0){30}}

\put(100,100){\circle{20}}
\put(100,100){\circle{30}}
\put(100,100){\circle*{8}}

\put(100,100){\oval(60,40)}
\put(120,100){\oval(60,40)[r]}
\put(95,105){\oval(60,40)[lt]}

\multiput(90,60)(9,0){5}{\line(1,0){1}}
\multiput(93,60)(9,0){5}{\line(1,0){4}}
\end{picture}

Jeden řádek.
Jeden řádek.

Přı́padně
vı́ce řádků.
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Pro zpřehledněnı́ obrázku jsou připojena „pravı́tka“ s dı́ly po deseti bodech. Je
to zároveň ukázka toho, že můžeme bez problémů kreslit i mimo oblast vyhrazenou
v parametru prostředı́ picture. Pravı́tka jsou vykreslena těmito přı́kazy:

Výpis č. 2.26

\multiput(0,-12)(10,0){17}{\line(0,1){5}} % vodorovné pravı́tko
\put(0,-12)\line(1,0){160}}
\multiput(-12,0)(0,10){16}{\line(1,0){5}} % svislé pravı́tko
\put(-12,0)\line(0,1){150}}

To, jaké rozměry pro prostředı́ picture zadáme, určuje, kolik mı́sta bude pro ně
na stránce rezervováno. Protože nenı́ problém kreslit i mimo prostředı́ (to můžeme
vidět na výpisu 2.26, kde jsou použity záporné souřadnice), záležı́ na nás, kolik
mı́sta chceme mı́t vynecháno. Dokonce nenı́ problém vytvořit prostředı́ picture
s nulovými rozměry (v parametru (0,0)). Toho se využı́vá napřı́klad při umı́stěnı́
obrázku do záhlavı́ nebo vytvořenı́ „vodoznaku“ na pozadı́ stránky.

Přı́kaz Význam

\put(x,y){objekt} vložı́ objekt na dané souřadnice
\multiput(x,y)(dX,dY){počet}{objekt} vložı́ objekt počet-krát, začı́ná na souřad-

nicı́ch (x,y) a v každém kroku se posune
o dX na ose X a o dY na ose Y

\qbezier[počet](x1,y1)(x2,y2)(x3,y3) vykreslı́ Bezierovu křivku (začı́ná v prv-
nı́m bodě, končı́ v třetı́m, druhý určuje
zakřivenı́), v nepovinném parametru mů-
žeme určit, že se nevykreslı́ celá křivka,
ale pouze daný počet bodů z nı́

Tabulka 2.7: Přı́kazy pro kreslenı́, které se pı́šou přı́mo do prostředı́ picture

Přı́kaz Význam

\line(poměrX,poměrY){průmět} čára (úsečka) o zadaném poměru stran a délce
průmětu na osu X (u svislé čáry jejı́ délce), čı́sla
pro poměr jsou celá čı́sla z intervalu < −6, 6 >

\vector(poměrX,poměrY){průmět} vektor, jako u čáry, jen interval je < −4, 4 >

\circle{průměr} kružnice o daném průměru
\circle*{průměr} vyplněný kruh o daném průměru
\oval(osaX,osaY)[část] ovál se zadanými délkami vodorovné a svislé osy,

v nepovinném parametru můžeme určit část,
která se má vykreslit (jedno nebo dvě pı́smena
z t, b, l, r)

\shortstack[poz]{řádky} řádky textu, poz je zarovnánı́ vnitřku (l, r, c)

Tabulka 2.8: Přı́kazy objektů vkládaných do parametrů přı́kazů \put a \multiput
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V tabulce 2.8 máme seznam některých přı́kazů, které vytvářejı́ různé objekty.
Nenı́ to úplný seznam, protože zde můžeme použı́vat prakticky (téměř) cokoliv, co
jsme až dosud z LATEXu probrali včetně formátovaného textu, vkládaných obrázků
i různě upravovaných (ořı́znutı́, rotace, apod.), dokonce i vnořené prostředı́ picture.
To je výhoda zejména tehdy, když máme skupinu objektů, jejichž umı́stěnı́ je vzá-
jemně závislé a zatı́m nenı́ definitivnı́. Když je umı́stı́me do vnořeného prostředı́
picture, přesouváme celé toto prostředı́ bez „rozházenı́ “ objektů v něm umı́stě-
ných.

Přı́kaz Význam

\framebox(š,v)[poz]{obsah} rámeček s plným orámovánı́m o daných roz-
měrech (šı́řka, výška), do obsahu lze dát co-
koliv (i text nebo čáru), nepovinný parametr
určuje zarovnánı́ obsahu uvnitř (jedno nebo
dvě pı́smena z t, b, l, r, c)

\dashbox{element}(š,v)[poz]{obsah} rámeček s čárkovaným orámovánı́m, platı́
pro něj totéž co pro \framebox, jen navı́c
v parametru element určujeme délku čárek

\makebox(š,v)[poz]{obsah} rámeček bez orámovánı́, použı́vá se pro
přesnějšı́ umı́st’ovánı́ napřı́klad textu

Tabulka 2.9: Přı́kazy pro rámečky v prostředı́ picture

Pro vı́ceřádkový text se použı́vá bud’ kombinace přı́kazů \makebox a \parbox
(ten známe z kapitoly 2.7) nebo přı́kaz \shortstack. Na výpisu 2.27 vidı́me drobné
rozdı́ly v použı́vánı́ těchto možnostı́. Prvnı́ možnost dovoluje snadnějšı́ manipulaci
s textem samotným včetně výchozı́ho zarovnánı́ do bloku, řádky jsou zalamovány
automaticky. Při použitı́ druhé možnosti určujeme zarovnánı́ řádků v nepovinném
parametru, zalamovánı́ musı́me provést ručně (ale zato nemusı́me určovat šı́řku
čı́selně) a po každém zalomenı́ řádku je třeba znovu uvést formátovacı́ přı́kazy.

Výpis č. 2.27

\begin{picture}(98,80)
\put(0,0){\framebox(98,80){}}
\put(1,45){\makebox(95,30){\parbox{90pt}{\small Toto je
nějaký text zarovnaný \itshape do vı́ce řádků.}}}
\put(3,3){\shortstack[l]{\small Toto je nějaký text\\
\small zarovnaný \itshape do vı́ce\\ \small\itshape řádků.}}
\end{picture}

Toto je nějaký text
zarovnaný do vı́ce

řádků.

Toto je nějaký text
zarovnaný do vı́ce

řádků.

Zde probı́rané možnosti prostředı́ picture nejsou plným popisem, podrobnějšı́
informace jsou napřı́klad v nápovědě, [T31], [T43] (krásné přı́klady, v odkazech
nahoře) a [T39]. Existujı́ také balı́čky, které rozšiřujı́ možnosti prostředı́ picture –
napřı́klad epic, eepic, pictex, xypic, pmgraph, sada balı́čků pstricks (zajı́mavé
jsou tutoriály na [T44]).
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2.10.3 Tabulátory

Pro tabulátory máme v LATEXu prostředı́ tabbing. Uvnitř prostředı́ použı́váme přede-
všı́m přı́kazy na nastavovánı́ tabulátorových zarážek a přecházenı́ mezi nimi a sa-
mozřejmě přı́kazy pro přechod na nový řádek. Máme možnost také uložit pozice
tabulátorů a kdykoliv je znovu využı́t, ale pouze v tomtéž prostředı́ tabbing. Toho
se využı́vá předevšı́m při změně nastavenı́ zarážek a opětovném návratu k předcho-
zı́mu nastavenı́.

Přı́kaz Význam

\= nastavenı́ tabulátorové zarážky na této pozici
\> přechod na dalšı́ zarážku (jako bychom stiskli klávesu Tab )

\’ předchozı́ text je svým pravým okrajem (s určitou malou mezerou)
zarovnán k předchozı́ zarážce

\‘ všechen dalšı́ text až do symbolu konce řádku posune k pravému
okraji, na řádku nesmı́ následovat žádné dalšı́ tabulátorové přı́kazy

\\ přechod na nový řádek, v prostředı́ tabbing zůstávajı́ tabulátorové
zarážky nastaveny

\kill pokud je tento přı́kaz použit na konci řádku mı́sto \\, tento řádek se
nevysázı́, ale všechny na něm nastavené tabulátorové zarážky zůstá-
vajı́ nastaveny

\pushtabs uložı́ pozice všech zarážek do zásobnı́ku tabulátorových zarážek
\poptabs vyjme poslednı́ uložené pozice zarážek ze zásobnı́ku tabulátorových

zarážek a nastavı́ je

Tabulka 2.10: Přı́kazy pro tabulátory

Přı́kazy \pushtabs a \poptabs jsou párové (ke každému \pushtabs musı́ být
jeden \poptabs) a můžeme je vnořovat podobně jako symboly hranice skupiny { }.

Obvyklý způsob použitı́ je nastavenı́ zarážek pomocı́ \= na zvláštnı́m řádku, kde
pro jednotlivé části použijeme vždy z daného „sloupce“ nejširšı́ část přes všechny
řádky (přı́padně ještě rozšı́řı́me) a na konci tohoto zvláštnı́ho řádku napı́šeme přı́kaz
\kill. Tento řádek bude sloužit pouze pro nastavenı́, nevysázı́ se. Dalšı́ řádky již
pı́šeme běžným způsobem, pro pohyb k dalšı́m zarážkám použı́váme přı́kazy \>, \’
a \‘ a řádky končı́me přı́kazem \\.

Přı́klad 2.13 Zarovnánı́ k tabulátorovým zarážkám si ukážeme na fragmentu
úlohy ze strany I. Text je zarovnán k zarážce vlevo, čı́sla vpravo.

Výpis č. 2.28

\begin{tabbing}
Počet xx \= zajı́ců xx 126 \= x \kill
Počet \> sobů \> 126 \’\\
\> lišek \> 12 \’\\
\> zajı́ců \> 54 \’\\[.8ex]
\textbf{Celkem zvı́řat}\>\> \textbf{192}\’
\end{tabbing}

Počet sobů 126
lišek 12
zajı́ců 54

Celkem zvı́řat 192
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Prostředı́ tabbing nelze vnořovat, kromě přı́padu, kdy je „vnořené“ prostředı́
uzavřeno do přı́kazu \parbox.

Stejného vizuálnı́ho efektu, jako pomocı́ prostředı́ tabbing, dosáhneme napřı́-
klad použitı́m tabulek (viz kapitola 2.10.4) nebo skládánı́m prostředı́ minipage či
přı́kazů \parbox. Zde pak máme napřı́klad možnost použı́vat pružné čáry plné či
tečkované, u tabulek také podtrženı́ a shrnutı́ vı́ce buněk. Ve výpisu 2.29 vidı́me
kombinaci dvou použitı́ přı́kazu \parbox a pružné čáry.

Výpis č. 2.29

\parbox{3em}{ Počet}
\parbox[t]{8em}{%

sobů\dotfill 126\\
lišek\dotfill 12\\
zajı́ců\dotfill 54 }

Počet sobů . . . . . . . . 126
lišek. . . . . . . . . .12
zajı́ců . . . . . . . . 54

2.10.4 Tabulky

Pro sazbu tabulek použı́váme prostředı́ tabular (pozor, neplést si s prostředı́m pro
tabulátory) s následujı́cı́m způsobem použitı́:

\begin{tabular}{určenı́ sloupců} ... \end{tabular}

V parametru prostředı́ musı́me určit počet sloupců s jejich zarovnánı́m a oddělo-
vače.

Zarovnánı́ sloupců se zadává pı́smeny l, r, c, p (jeden řádek zarovnaný doleva,
doprava, vycentrovaný, a nebo odstavec zarovnaný do bloku), při použitı́ p určujeme
šı́řku odstavce v parametru, napřı́klad p{2cm} je sloupec široký 2 centimetry, ve
kterém jsou odstavce zarovnány do bloku.

Oddělovač může být bud’ čára (zadáme symbol |) nebo jakýkoliv jiný symbol
včetně matematických. Dvojitou čáru zadáme dvěma symboly pro čáru za sebou,
tedy ||, jiný oddělovač než čáru určı́me přı́kazem @{znaky}. Když oddělovač neza-
dáme vůbec, sázı́ se pro oddělenı́ sloupců mezera, pokud nechceme ani tu mezeru,
zadáme jako oddělovač @{}.

Protože oddělovače oddělujı́ sloupce a sloupce jsou určeny svým zarovnánı́m,
parametr určenı́ sloupců se zadává napřı́klad takto:

{|l|c|p{.3\textwidth}|r|} prvnı́ sloupec je zarovnán vlevo, druhý na střed,
třetı́ je odstavec o šı́řce přibližně třetiny stránky a čtvrtý je zarovnán doprava,
mezi nimi jsou jako oddělovače použity čáry, stejně jako na stranách celé ta-
bulky,

{|l||r@{$+$}r@{$+$}r@{$=$}r|} prvnı́ sloupec je zarovnán doleva, pak násle-
duje dvojitá čára, zbylé sloupce jsou zarovnány doprava (zřejmě pro čı́sla)
a mezi nimi jsou použity jako oddělovače symboly + a =,
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{l|r@{,}l} prvnı́ sloupec je zřejmě použit pro běžný text, dalšı́ dva dohromady
tvořı́ reálné čı́slo s desetinnou čárkou (druhý sloupec zaznamenává celou část,
třetı́ desetinnou část).

Vodorovnou čáru tvořı́me přı́kazem \hline, dvojitou čáru zdvojenı́m tohoto přı́-
kazu. Vodorovnou čáru přes daný počet sloupců zı́skáme přı́kazem \cline{od-do},
kde zadáme čı́sla sloupců, mezi kterými má čára vést.

Vı́ce sloupců na jednom řádku (buněk) sloučı́me přı́kazem

\multicolumn{počet sloupců}{zarovnánı́}{obsah buňky}

Uvnitř tabulky použı́váme k oddělenı́ sloupců přı́kaz \\ přı́padně následovaný
přı́kazy \hline či \cline, buňky na řádku oddělujeme symbolem &.

Přı́klad 2.14 Použitı́ základnı́ch možnostı́ tabulky si ukážeme na jednoduchých
přı́kladech vycházejı́cı́ch z výpisu 2.28 na straně 78. Ve výpisu 2.32 je v zarovnánı́ na
okrajı́ch přı́kaz @{}, aby podtrhávacı́ čára „nepřečnı́vala“. Bez použitı́ tohoto přı́kazu
by se mı́sto okrajové čáry vložila mezera, jenže my nechceme ani tu mezeru.

Výpis č. 2.30

\begin{tabular}{|ll|r|}\hline
Počet & sobů & 126\\

& lišek & 12 \\
& zajı́ců & 54 \\ \hline\hline

\multicolumn{2}{|l|}{\bfseries Celkem zvı́řat}&
\bfseries 192\\ \hline

\end{tabular}

Počet sobů 126
lišek 12
zajı́ců 54

Celkem zvı́řat 192

Výpis č. 2.31

\begin{tabular}{|l|r|}\hline
\bfseries Zvı́ře & \bfseries Počet\\ \hline\hline
sob & 126\\ \hline
liška & 12 \\ \hline
zajı́c & 54 \\ \hline\hline
\bfseries Celkem zvı́řat & \bfseries 192\\ \hline
\end{tabular}

Zvı́ře Počet

sob 126
liška 12
zajı́c 54

Celkem 192

Výpis č. 2.32

\begin{tabular}{@{}lp{7.7em}@{}}
Počet & sobů \dotfill 126\\

& lišek \dotfill 12 \\
& zajı́ců \dotfill 54 \\[.3ex] \hline

\multicolumn{2}{@{}l@{}}{\bfseries Celkem zvı́řat
\dotfill 192}

\end{tabular}

Počet sobů . . . . . . .126
lišek . . . . . . . . 12
zajı́ců . . . . . . . 54

Celkem zvı́řat ....192
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Přı́klad 2.15 V tomto přı́kladu se podı́váme na zarovnánı́ reálných čı́sel podle
desetinné čárky. Celou část zarovnáme doprava, desetinnou doleva a před sečtenı́m
podtrhneme.

Výpis č. 2.33

\begin{tabular}{lr@{,}l}
Výpočet: & 1\,284&52\\
&716&4\\
&0&977\\
&35&0\\ \cline{2-3}
&2\,036&897
\end{tabular}

Výpočet: 1 284,52
716,4

0,977
35,0

2 036,897

Přı́klad 2.16 Ukážeme si vytvořenı́ vlastnı́ch oddělovačů na jednoduchém „sčı́ta-
cı́m“ přı́kladu. Ve výpisu 2.34 je kód přı́kladu, v tabulce 2.11 pak výsledek.

Výpis č. 2.34

\begin{tabular}{l||c@{~+~}c@{~+~}c@{~=~}c}
\bfseries Jméno & Přı́klad 1 & Přı́klad 2 & Přı́klad 3 & Celkem\\ \hline\hline
\itshape Maximum: &\itshape 6&\itshape 7&\itshape 7&\itshape 20\\ \hline\hline
Blažková & 3 & 7 & 4 & 14\\ \hline
Hrubý &2&3&1&6\\ \hline
Novák & 4 & 5 & 7 & 16\\ \hline
\dots
\end{tabular}

Jméno Přı́klad 1 + Přı́klad 2 + Přı́klad 3 = Celkem

Maximum: 6 + 7 + 7 = 20

Blažková 3 + 7 + 4 = 14
Hrubý 2 + 3 + 1 = 6
Novák 4 + 5 + 7 = 16
. . .

Tabulka 2.11: Ukázka tabulky s vlastnı́mi oddělovači

Ukázali jsme si pouze základnı́ možnosti tvorby tabulek. Možnostı́ je vı́ce a navı́c
je můžeme rozšı́řit použitı́m různých balı́čků, napřı́klad tabularx, supertabular,
slashbox, apod. Obvykle jde předevšı́m o možnost vytvářet tabulky zasahujı́cı́ na
vı́ce stran (zde ukázané tabulky mohou být pouze na jedné straně). Podrobnosti
viz napřı́klad [T31] nebo na prakticky každém odkazu ze seznamu literatury tohoto
dokumentu vedoucı́mu na některou učebnici LATEXu.
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2.10.5 Plovoucı́ prostředı́

V tomto dokumentu jsme si mohli všimnout způsobu vkládánı́ obrázků a tabulek.
Tyto objekty jsou obvykle pojmenované (majı́ popisek s čı́slem), lze se na ně odka-
zovat a jsou umı́stěny tak, že sice někdy nebývajı́ přesně tam, kde se o nich pı́še,
ale v přı́padě, že by přes ně mohl vést stránkový zlom (konec stránky), přesunou se
na dalšı́ stránku bez toho, aby mı́sto nich na předchozı́ stránce zůstalo kus mı́sta
nevyužitého.

Tuto funkci v LATEXu plnı́ plovoucı́ prostředı́. Nazývá se tak, protože „plave“ na
stranách tak, aby se vyhnulo stránkovému zlomu a umı́stilo se tak, jak si autor přeje
(pokud je to možné). Rozlišujeme dvě základnı́ plovoucı́ prostředı́ – pro tabulky je to
table a pro obrázky a jiné grafické objekty je to figure. Použı́vajı́ se stejně:

\begin{table}[umı́stěnı́]
\centering % vycentrovánı́

... tady bude tabulka,
třeba prostředı́ tabular

\caption{popisek tabulky}
\label{pojmenovánı́ pro odkazy}
\end{table}

\begin{figure}[umı́stěnı́]
\centering % vycentrovánı́

... tady bude objekt,
třeba prostředı́ picture

\caption{popisek objektu}
\label{pojmenovánı́ pro odkazy}
\end{figure}

V parametru umı́stěnı́ určujeme pı́smeny h, t, b, p, kde se má na stránce
objekt umı́stit, pokud to půjde (na mı́stě, na hornı́m okraji stránky, dolnı́m okraji
a nebo na zvláštnı́ stránce pouze pro plovoucı́ prostředı́, obvykle na konci kapitoly
nebo dokumentu). Pı́šeme vı́ce možnostı́, LATEX je zkoušı́ zleva – když se nepovede
umı́stit prostředı́ na mı́stě, posune ho na hornı́ okraj následujı́cı́ stránky apod.,
napřı́klad [htbp].

Tabulka 2.11 na straně 81 byla umı́stěna tı́mto kódem:

Výpis č. 2.35

\begin{table}[htb]
\centering
\begin{tabular}[...
...
\end{tabular}
\caption{Ukázka tabulky s~vlastnı́mi oddělovači}
\label{tab:scitani}
\end{table}

Na tuto tabulku se můžeme odkázat takto: v tabulce \ref{tab:scitani}
na straně \pageref{tab:scitani} ... – v tabulce 2.11 na straně 81 . . .

Přı́klad 2.17 Umı́stı́me obrázek slunečnice s popiskem. Použijeme přitom obrá-
zek, který jsme použı́vali v kapitole 2.11 na straně 73.
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Obrázek 2.8: Sluneč-
nice

Kdyby tento obrázek byl uprostřed strany, byl by vložen
a umı́stěn tı́mto kódem:

Výpis č. 2.36

\begin{figure}[htb]
\centering
\includegraphics{obr/slunecnice.eps}
\caption{Slunečnice}
\label{obr:slunecnice}
\end{figure}

Uvnitř plovoucı́ho prostředı́ nemusı́ být jen jedna tabulka či obrázek. Můžeme
tam vložit prakticky cokoliv (i text) a v jakémkoliv počtu, pak se objekty naskládajı́
vedle sebe. Napřı́klad v kapitole o MS Wordu je často použı́váno prostředı́ figure,
ve kterém je kromě obrázku vloženého přı́kazem \includegraphics také prostředı́
picture o velmi malých rozměrech pro popisovánı́ jednotlivých částı́ vloženého
obrázku.

Stejně jako u jiných témat, také u plovoucı́ch prostředı́ najdeme mnoho rozšı́-
řenı́ v podobě balı́čků. Napřı́klad balı́čky wrapfig, picins a floatflt nám umož-
ňujı́ vkládat plovoucı́ prostředı́ do vı́cesloupcového textu, prostředı́ minipage či
přı́kazu \parbox, nebo je obtékat.

Balı́ček picins má bohužel dokumentaci jen v němčině, ale některé jeho mož-
nosti při vkládánı́ objektů jsou pěkně popsány v [T31], v nápovědě nebo na inter-
netu (stačı́ na http://google.com zadat heslo „picins documentation“ nebo jen
„picins“). Zajı́mavý je předevšı́m přı́kaz \parpic, který kromě zajištěnı́ obtékánı́ ob-
jektu do něj vloženého umı́ napřı́klad také kolem objektu vytvořit rámečky různých
tvarů včetně oválného.

Balı́ček floatflt obsahuje prostředı́ floatingfigure a floatingtable, ba-
lı́ček wrapfig obsahuje prostředı́ wrapfigure a wraptable. Jsou podobné, ale
o něco vı́ce možnostı́ nabı́zı́ balı́ček wrapfig. Obrázek 2.8 byl ve skutečnosti vložen
tı́mto kódem (je načten balı́ček wrapfig):

Výpis č. 2.37

\begin{wrapfigure}[9]{l}{115pt} % přes 9 řádků, vlevo, šı́řka 115 bodů
\centering
\includegraphics{obr/slunecnice.eps}
\caption{Slunečnice}
\label{obr:slunecnice}
\end{wrapfigure}
Kdyby tento obrázek byl uprostřed strany ...

Balı́čky subfig a subfigure dovolujı́ členit plovoucı́ prostředı́ na menšı́ po-
jmenované části, tedy máme v jednom prostředı́ vı́ce obrázků a každý má vlastnı́
popisek. Pomocı́ balı́čku subfloat vytvářı́me vı́ceúrovňové čı́slovánı́ různých plo-
voucı́ch prostředı́, captcont rozděluje dlouhá plovoucı́ prostředı́ na vı́ce stránek
a ccaption dovoluje kromě jiného vytvářet i nečı́slované nebo vı́cejazyčné popisky.

http://google.com
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2.10.6 Boxy

Box (rámeček) je oblast stránky, se kterou lze zacházet do určité mı́ry samostatně.
Existuje vı́ce různých druhů boxů a každý má své specifické vlastnosti. S některými
jsme se už setkali, kromě přı́kazu \fbox a \parbox předevšı́m v prostředı́ picture
v kapitole 2.10.2 (jsou v tabulce 2.9 na straně 77)11. Stejně pojmenované boxy, ale
s trochu jinou syntaxı́ (způsobem použitı́) použı́váme i mimo nákresy v textu, a také
některé dalšı́.

Z boxů již známe ten, do kterého dáváme objekty (včetně textu), které chceme
srovnat na určitou šı́řku, objekty mohou být i na vı́ce řádcı́ch:

\parbox[zarovnánı́ od předchozı́ho]{šı́řka}{obsah}

Dalšı́ boxy použı́váme, když potřebujeme text či jiné objekty vhodně zarovnat či
umı́stit, přı́padně orámovat

\makebox[šı́řka][zarovnánı́]{obsah}
\mbox{obsah}
\framebox[šı́řka][zarovnánı́]{obsah}
\fbox{obsah}

Přı́kaz \makebox prostě zarovná (c, l, r) text v dané šı́řce (třeba vycentruje na
tuto šı́řku). Zjednodušenou variantou je přı́kaz \mbox, kde nepotřebujeme žádné
nepovinné parametry, použı́váme ho třeba tehdy, když některé slovo nebo několik
slov určitě nechceme rozdělit na konci řádku, chceme je udržet celé „v kuse“. Dalšı́
dva přı́kazy majı́ podobný význam, jen navı́c přidávajı́ rámeček kolem svého obsahu.

Nevýhodou těchto přı́kazů je, že nedokážou pracovat s vı́ce řádky. To se řešı́
vnořenı́m obsahu do přı́kazu \parbox nebo do prostředı́ minipage, napřı́klad takto:

\fbox{\parbox[zarovnánı́ od předchozı́ho]{šı́řka}{obsah}}

Dalšı́ typ boxu sloužı́ k vertikálnı́mu posouvánı́ objektů. Někdy potřebujeme
část textu, obrázek či cokoliv jiného posunout nahoru nebo dolů, pak použijeme
tento přı́kaz:

\raisebox{zvýšenı́}{obsah}

Parametr zvýšenı́ je délka, o kolik se má obsah posunout nahoru, když je délka
záporná, posouvá se dolů. Opět při práci s vı́ce řádky musı́me použı́t kombinaci
s přı́kazem \parbox nebo prostředı́m minipage.

V boxech můžeme jako šı́řku či jinou mı́ru použı́t také některé délkové registry.
Často se použı́vajı́ napřı́klad \width (šı́řka obsahu), \height (výška obsahu od
základnı́ čáry řádku nahoru), \depth (hloubka obsahu od základnı́ čáry řádku
dolů), \totalheight (celková výška obsahu – součet předchozı́ch dvou).

11Pozor na rozdı́l mezi stejně pojmenovanými boxy pro text a pro prostředı́ picture – majı́ jiné
parametry!
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Přı́klad 2.18 Vyzkoušı́me si použitı́ přı́kazu \framebox s nepovinným paramet-
rem, jeho kombinaci s přı́kazem \makebox a také zvyšovánı́ a snižovánı́ textu. Všim-
něte si u druhého boxu zadánı́ dvojnásobku šı́řky obsahu. Pro orámovánı́ výsledku
kódu výpisu je použita kombinace přı́kazu \fbox a prostředı́ minipage.

Výpis č. 2.38

Pı́šeme orámovaný text na
\framebox[10em]{danou šı́řku}
10 čtverčı́ků, a dalšı́ v boxu širokém dvojnásobek
tohoto \framebox[2\width]{textu}.

Máme orámované pı́smenko \fbox{j} a pak pı́smenko
\fbox{\makebox[\totalheight]{j}}
ve čtvercovém rámečku.

% zvyšovánı́ a snižovánı́ objektů:
Pı́šeme \raisebox{3pt}{zvýšený,} normálnı́ a také
\raisebox{-3pt}{snı́žený text.}

Pı́šeme orámovaný text

na danou šı́řku 10
čtverčı́ků, a dalšı́ v boxu
širokém dvojnásobek to-
hoto textu .

Máme orámované pı́smen-
ko j a pak pı́smenko j

ve čtvercovém rámečku.

Pı́šeme zvýšený, normálnı́
a také snı́žený text.

Boxy lze také ukládat a znovu použı́vat, to se týká i boxů v prostředı́ picture.
Podrobnosti najdeme napřı́klad v nápovědě nebo v [T31].

2.10.7 Barvy

Podporu barev přidáme balı́čkem color s nepovinným parametrem dvips nebo
pdftex podle toho, jestli chceme překládat přes formát DVI a PS (LaTeX=>DVI nebo
LaTeX=>PS=>PDF) nebo přı́mo do PDF (LaTeX=>PDF). Máme možnost použı́vat před-
definované barvy (s anglickými názvy) pro text, pozadı́ textu, boxy i kreslenı́, a také
vytvářet si vlastnı́ barvy.

Následujı́cı́ přı́kazy sloužı́ k nastavenı́ určité barvy pro úsek textu, a to pro
samotný text, pozadı́ textu nebo obojı́ najednou:

\textcolor{barva}{text}
\colorbox{barva pozadı́}{text}
\fcolorbox{barva rámečku}{barva pozadı́}{text}

Existujı́ i přı́kazy platné od mı́sta jejich uvedenı́ až do konce skupiny, sloužı́
pro nastavenı́ barvy textu (nebo barvy pro kreslenı́ v prostředı́ picture) nebo pro
nastavenı́ barvy pozadı́ celé stránky (změna barvy pozadı́ stránky se projevı́ až po
překladu do formátu PS nebo PDF):

\color{barva}
\pagecolor{barva pozadı́}

Novou barvu vytvořı́me následujı́cı́m přı́kazem, ve kterém zadáme název nové
barvy, čı́selnou specifikaci a pokud možno také typ (obvykle se použije zkratka rgb
pro barevnou kombinaci červené, zelené a modré nebo nebo gray pro odstı́n šedé):

\definecolor{název barvy}{typ barvy}{specifikace}
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Přı́klad 2.19 Ukážeme si použitı́ přı́kazů pro barvenı́ textu, jeho pozadı́ a kreslenı́,
a také vytvořenı́ vlastnı́ barvy.

Výpis č. 2.39

\textcolor{green}{Zelený text.}

\fcolorbox{blue}{yellow}{\parbox{6em}{%
\textcolor{red}{Červený text} %
\color{blue} v~rámečku}}

\def\ctverecek{\rule{1em}{1em}}
\textcolor{black}{\ctverecek}
\textcolor{blue}{\ctverecek}
\textcolor{red}{\ctverecek}
\textcolor{green}{\ctverecek}
\textcolor{cyan}{\ctverecek}
\textcolor{yellow}{\ctverecek}

% barvy se definujı́ čı́sly z intervalu < 0, 1 >,
% vyššı́ čı́slo znamená světlejšı́ barvu:
\definecolor{svmodra}{rgb}{.65,.65,1}
\definecolor{seda}{gray}{.4}
\colorbox{svmodra}{Světlemodré \color{seda} pozadı́.}

\begin{picture}(1,100)
\color{red} % odted’ se kreslı́ červenou
\qbezier(40,30)(50,0)(75,90)
\end{picture}

Zelený text.

Červený text
v rámečku

Světlemodré pozadı́.

2.10.8 Hypertextové odkazy

Hypertextové odkazy vytvářı́me pomocı́ balı́čku url nebo hyperref.

Použitı́ balı́čku url je jednoduché. Načteme ho přı́kazem \usepackage (nenı́
třeba zadávat žádné dalšı́ parametry) a hypertextový odkaz vložı́me přı́kazem

\url{adresa}

Zadaná adresa je vypsána neproporcionálnı́m pı́smem („psacı́ stroj“) a jsou zobra-
zeny znaky, které by jinak bylo nutné zobrazovat pomocı́ přı́kazů (napřı́klad vlnovka
nebo zpětné lomı́tko). Pokud si přejeme ještě dále adresu formátovat, musı́me to
udělat ručně. Napřı́klad modrou barvu a podtrženı́ nastavı́me takto:

{\color{blue}\underline{\url{http://nejaka.adresa.cz}}}

Vypadá to jako hypertextový odkaz, ale nechová se to tak. Pro dokument, který
se má tisknout, je to dostačujı́cı́, ale pokud chceme, aby byl použitelný i v elektro-
nické podobě včetně možnosti použı́vat odkazy, musı́me volit jiné řešenı́. Existuje
program dvipdfm, který dokáže vyrobit dokument s těmito vlastnostmi, ale je nutno
znát parametry, se kterými se má spustit.
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Jednoduššı́m řešenı́m je použitı́ balı́čku hyperref, hypertextové odkazy fungujı́
až v souboru PDF. Je důkladně popsán v dokumentaci, kterou snadno najdeme (viz
kapitola 2.6.2). Je spı́še určen pro překlad přı́mo do PDF (LaTeX=>PDF), ale lze ho
použı́t i při překladu přes DVI a PS (LaTeX=>PS=>PDF) s tı́m, že některé volby budou
dělat trochu problémy.

Balı́ček hyperref nabı́zı́ mnoho voleb (některé se vlastně ani netýkajı́ hyper-
textových odkazů), i proto stojı́ za to prostudovat si dokumentaci. Volby se zadávajı́
bud’ při načı́tánı́ balı́čku přı́kazem \usepackage, nebo v přı́kazu \hypersetup.

Při překladu přes PS můžeme balı́ček načı́st napřı́klad s těmito volbami:

\usepackage[dvips,colorlinks,linkcolor={blue},%
citecolor={green},urlcolor={blue}]{hyperref}

Volba dvips je nutná při překladu přes DVI a PS, volba colorlinks znamená, že se
odkazy majı́ zobrazovat barevně (byly by však aktivnı́ i bez barevného zvýrazněnı́),
dalšı́ volby určujı́ barvy pro jednotlivé druhy odkazů. V našem přı́padě jsou od-
kazy vedoucı́ dovnitř dokumentu (třeba na určitou stranu, kapitolu nebo v obsahu)
modré, odkazy do seznamu literatury zelené a odkazy „ven“ (internetové) modré.

Názvy barev (předdefinovaných) můžeme použı́vat i bez načtenı́ balı́čku color,
ale pokud chceme vytvářet vlastnı́ barvy, musı́me tento balı́ček do dokumentu na-
čı́st (a barvu samozřejmě definovat ještě před jejı́m přı́padným použitı́m ve volbách
balı́čku hyperref).

Balı́ček hyperref také umožňuje vytvářet záložky podle kapitol dokumentu,
tyto záložky se pak zobrazı́ v některých prohlı́žečı́ch (napřı́klad Adobe Reader) vlevo
vedle dokumentu na záložce Záložky. Při překladu přı́mo do PDF nebývajı́ problémy,
ale pokud překládáme přes PS, musı́me zajistit, aby se správně zobrazovaly české
znaky (tı́m zároveň vyřešı́me i problémy s češtinou při použı́vánı́ aktivnı́ch odkazů).
Použijeme balı́ček inputenc s vhodnou volbou (napřı́klad latin2) a u balı́čku
hyperref volbu unicode.

Celkově po vyřešenı́ vlastnı́ch barev, češtiny a záložek (včetně čı́sel kapitol) může
načtenı́ balı́čku vypadat podle výpisu 2.40.

Výpis č. 2.40

\usepackage[dvips]{color}
\definecolor{barvaodkaz}{rgb}{.1,.1,.4}

\usepackage[latin2]{inputenc}
\usepackage[dvips,bookmarksnumbered,unicode,colorlinks,%

linkcolor={barvaodkaz},citecolor={green},urlcolor={blue}]{hyperref}

Když máme načten balı́ček hyperref, odkazy „dovnitř dokumentu“ (obsah, od-
kazy na seznam literatury, na tabulky apod.) jsou označeny a aktivovány automa-
ticky, odkazy na WWW stránky označı́me napřı́klad následujı́cı́mi přı́kazy (druhý
přı́kaz použijeme, pokud nechceme do dokumentu vložit celou adresu, ale odkaz
má být funkčnı́):

\url{http://nejaka.adresa.cz}
\href{http://nejaka.adresa.cz}{slovnı́ odkaz}
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2.11 Seznam literatury a rejstřı́k

Seznam literatury se vkládá na dané mı́sto prostředı́m thebibliography, jehož
parametrem je „nejširšı́ čı́slo“ použité při čı́slovánı́, obvykle se použije 99. Položky
začı́najı́ přı́kazem \bibitem, kde jako povinný parametr zadáváme název pro křı́žové
odkazy, jako nepovinný parametr můžeme použı́t slovnı́ pojmenovánı́ položky (mı́sto
čı́slovánı́). Ve výpisu 2.41 vidı́me způsob vytvořenı́ čı́slovaného seznamu literatury,
za výpisem je vysázený seznam.

Výpis č. 2.41

\begin{thebibliography}{99}
\bibitem{linuxnoviny} \textsc{Dvořák}, V. \emph{WIN95 + RH6.2 = 10GB HDD.}

Linuxové noviny $[$online$]$. 2001\\
URL: \url{http://www.linux.cz/noviny/2001-08/clanek05.html}
$[$cit. 18. 10. 2006$]$

\bibitem{vaznyfeynman} \textsc{Feynman}, R. P. \emph{To snad nemyslı́te vážně!}
Praha, Mladá Fronta, 1989.

\bibitem{libgaher} \textsc{Gahér}, F. \emph{Logické hádanky, hlavolamy
a paradoxy.} Bratislava, Iris, 1997.

\end{thebibliography}

[1] DVOŘÁK, V. WIN95 + RH6.2 = 10GB HDD. Linuxové noviny [online]. 2001
URL: http://www.linux.cz/noviny/2001-08/clanek05.html [cit. 18. 10. 2006]

[2] FEYNMAN, R. P. To snad nemyslı́te vážně! Praha, Mladá Fronta, 1989.

[3] GAHÉR, F. Logické hádanky, hlavolamy a paradoxy. Bratislava, Iris, 1997.

Na položky seznamu se odkazujeme přı́kazem \cite[text]{odkaz}. Povinný
parametr odkaz je odkazem na položku, v nepovinném parametru můžeme zadat
třeba čı́slo stránky nebo kapitolu. Podle výpisu 2.41 můžeme vytvořit třeba tyto
odkazy:

\cite{linuxnoviny}
\cite[s. 25]{vaznyfeynman}

Položky seznamu literatury můžeme mı́t pojmenovány i slovně, obvykle se po-
užı́vá přı́jmenı́ autora s rokem vydánı́, při vı́ce knihách jednoho autora ve stejném
roce přidáváme ještě pı́smenka a, b, . . . Použitı́ vidı́me na výpisu 2.42.

Výpis č. 2.42

\begin{thebibliography}{99}
...
\bibitem[Feynman89]{vaznyfeynman} \textsc{Feynman}, R. P. \emph{To snad nemyslı́te
vážně!} Praha, Mladá Fronta, 1989.
...
\end{thebibliography}

http://www.linux.cz/noviny/2001-08/clanek05.html
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Do seznamu literatury dostaneme:

. . .

[Feynman89] FEYNMAN, R. P. To snad nemyslı́te vážně! Praha, Mladá Fronta, 1989.

. . .

Odkaz ve tvaru \cite{vaznyfeynman} se vysázı́ jako [Feynman89], odkaz s ne-
povinným parametrem \cite[s. 25]{vaznyfeynman} jako [Feynman89, s. 25].

Pro vysázenı́ rejstřı́ku potřebujeme balı́ček makeidx nebo csindex. Ten prvnı́ je
určitě ve všech distribucı́ch, ten druhý bude asi třeba doinstalovat.

Tedy načteme balı́ček, dále ještě v preambuli (třeba hned za přı́kazem pro na-
čtenı́ balı́čku makeidx) napı́šeme přı́kaz \makeindex, kterým dáme najevo, že se má
vytvářet pomocný soubor pro vytvořenı́ rejstřı́ku. Na mı́stě, kde chceme mı́t rejstřı́k
vysázený, dáme přı́kaz \printindex.

Musı́me také označit mı́sta a pojmy, které chceme do rejstřı́ku zahrnout. Na
daném mı́stě dokumentu pak použijeme přı́kaz \index{pojem}. Máme k dispozici
i dalšı́ možnosti strukturovánı́ rejstřı́ku, najdeme je napřı́klad v nápovědě. Užitečný
může být také balı́ček index.

2.12 Dokumentové seznamy podle stylů

Vytvářenı́ dokumentových seznamů je v LATEXu poměrně dobře automatizované.
Technicky probı́há tak, že existujı́ speciálnı́ soubory s tı́m, co má v daném seznamu
být (s přı́ponou toc pro obsah, lot pro seznam tabulek, lof pro seznam obrázků,
idx pro rejstřı́k, apod.), a při překladu se údaje berou právě z těchto souborů.

Seznamy se vytvářejı́ z toho, co bylo vygenerováno při minulém překladu. Proto
je nutné při změně údajů v souborech (třeba přidánı́ kapitoly) provést překlad ale-

spoň dvakrát, aby seznamy byly aktuálnı́, přı́padně i vı́cekrát (když se vloženı́m
nebo rozšı́řenı́m seznamu měnı́ rozloženı́ stránek, napřı́klad obsah se rozšı́řı́ na
dalšı́ stránku).

Obsah, seznam tabulek a seznam obrázků vložı́me na dané mı́sto přı́kazy

\tableofcontents
\listoftables
\listoffigures

Dokonce tyto přı́kazy mohou následovat přı́mo za sebou (nemusı́me mı́t samozřejmě
všechny, jen ty, které potřebujeme), ale pokud použı́váme třı́du article nebo z nı́
odvozenou, je vhodné mezi ně vložit přı́kaz \newpage.

Do obsahu se automaticky neřadı́ nečı́slované nadpisy. Protože však občas po-
třebujeme mı́t v obsahu kapitolu, kterou nechceme čı́slovat, nebo dokonce chceme
přidat řádek, který se ke kapitolám vůbec nevztahuje, máme k dispozici dva přı́kazy,
a to přı́kaz \addcontentsline, který použı́váme při vloženı́ „běžného“ nadpisu do
určité úrovně obsahu (zadáváme úroveň slovem chapter, section, subsection
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apod.), a přı́kaz \addtocontents sloužı́cı́ ke vloženı́ prakticky jakéhokoliv textu do
obsahu (můžeme také použı́vat formátovacı́ přı́kazy, ale ne úplně libovolně).

Výpis č. 2.43

\chapter*{Úvod}
\addcontentsline{toc}{chapter}{Úvod}
...
\chapter*{Přı́lohy} % nadpis můžeme i formátovat nebo oživit obrázkem, což jsme
\addtocontents{\bigskip\noindent\bfseries{Přı́lohy}} % zde nepoužili
\thispagestyle{empty}
...
\newpage
\addcontentsline{toc}{chapter}{Rejstřı́k}
\printindex

Ve výpisu 2.43 máme nejdřı́v vloženı́ nečı́slované kapitoly s názvem Úvod do ob-
sahu (zkratka toc) na prvnı́ úroveň (chapter, ve třı́dě article bychom zde použili
section). Dále vkládáme do obsahu řádek oddělujı́cı́ přı́lohy od běžných kapitol,
ale nechceme na tomto řádku obsahu čı́slo stránky, které jsme ostatně odbourali
i na stránce samotné, proto použijeme přı́kaz \addtocontents a sami si určı́me,
co a jak bude zobrazeno (inspiraci můžeme hledat přı́mo v souboru s přı́ponou toc
stejně nazvaném jako samotný dokument).

Třetı́ zásah do obsahu je vloženı́ odkazu na kapitolu s rejstřı́kem. Tato kapi-
tola se sice v dokumentu správně nazve, ale nenı́ zahrnuta do rejstřı́ku. Nemů-
žeme použı́t přesně stejný postup jako u kapitoly Úvod, protože při použitı́ přı́kazu
\addcontentsline až za přı́kazem načı́tajı́cı́m rejstřı́k by se do obsahu vložilo čı́slo
poslednı́ strany rejstřı́ku mı́sto strany s jeho začátkem, proto přı́kaz umı́stı́me před
přı́kaz pro načtenı́ rejstřı́ku, ale aby se nevložilo čı́slo o 1 menšı́ než chceme, musı́me
ještě použı́t přı́kaz \newpage.

Zatı́m jsme v přı́kazech \addcontentsline a \addtocontents použı́vali zkrat-
ku toc, která znamenala, že pracujeme s obsahem. Tyto přı́kazy můžeme použı́t
také na seznam tabulek a seznam obrázků, ale mı́sto toc musı́me použı́t lot (ta-
bulky) nebo lof (obrázky).

2.13 Rozměry stránky

Protože evropské dokumenty majı́ obvykle poněkud jiné rozměry potištěné oblasti
stránky než americké (TEX je americký produkt), můžeme použı́t balı́ček a4wide,
který nastavı́ evropské rozměry podle formátu A4, ale u třı́dy dokumentu musı́me
mı́t uveden nepovinný parametr a4paper, napřı́klad takto:

\documentclass[a4paper,12pt]{article}
\usepackage{czech,a4wide}

Jestliže potřebujeme upravit rozměr (délku) pouze jedné stránky, vystačı́me si
s přı́kazem \enlargethispage{vzdálenost}, kde vzdálenost je délka, o kterou
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chceme stránku prodloužit (nebo zkrátit, když použijeme záporné čı́slo). Napřı́klad
pokud se nám nevejde na stránku něco, co nechceme mı́t posunuto až na dalšı́
stránku, použijeme tento přı́kaz s parametrem 1em (samozřejmě na té stránce, kte-
rou chceme prodloužit, raději výše). Když to nestačı́, zvážı́me, zda opravdu nechceme
daný objekt nebo odstavec umı́stit až na dalšı́ stránce, měli bychom brát v úvahu
i estetické hledisko.

Veškeré rozměry týkajı́cı́ se stránky jsou uloženy v délkových registrech. Ně-
které z nich můžeme měnit, jiné ne, obvykle z důvodu vzájemné závislosti. Vı́ce se
podı́váme na tuto problematiku až v přı́loze , ted’ si ukážeme na přı́kladu způsob
nastavenı́ některých rozměrů stránky.

U některých údajů najdeme záporná čı́sla. Je to proto, že u hornı́ho a levého
okraje se ještě navı́c počı́tá „prázdná“ vzdálenost přibližně 1 palec (1in), kterou
můžeme přı́padně záporným čı́slem zmenšit. Napřı́klad hornı́ (prázdný) okraj nad
textem je 1 palec plus (nebo mı́nus) obsah určitého délkového registru.

Přı́klad 2.20 Použijeme délkové registry pro přı́mé nastavenı́ rozměrů stránky.
Všechny nı́že uvedené přı́kazy musı́ být v preambuli dokumentu, tedy ještě před
přı́kazem \begin{document}.

Výpis č. 2.44

\setlength{\topmargin}{-0.2in} % hornı́ okraj
\setlength{\topskip}{0.3in} % mezi záhlavı́m a textem
\setlength{\textheight}{9.6in} % výška textu
\setlength{\leftmargin}{1cm} % (+1in) levý okraj
\setlength{\textwidth}{6in} % šı́řka textu

Z těchto registrů už známe přı́kaz \textwidth, který jsme použı́vali pro zjištěnı́
šı́řky potištěné části stránky, ostatnı́ už nejsou z tohoto hlediska tak důležité, ale
také použitelné. Napřı́klad když chceme vynechat půl strany mı́sta (vertikálně),
použijeme tento přı́kaz:

nějaký text
\vspace{.5\textheight}

dalšı́ text po vynechané polovině strany

Délkové registry nemusı́me nastavovat přı́mou hodnotou, můžeme jen upravo-
vat o určitou relativnı́ hodnotu. Napřı́klad když chceme rozšı́řit textovou část o jeden
centimetr, napı́šeme přı́kaz

\addtolength{\textwidth}{1cm}

Různé možnosti nastavenı́ rozměrů stránky máme v balı́čku geometry. Užitečný
může být také balı́ček layout, ve kterém je definován přı́kaz \layout, ukázku jeho
výstupu vidı́me na obrázku 2.9 na straně 92.
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1 one inch + \hoffset 2 one inch + \voffset
3 \oddsidemargin = 53pt 4 \topmargin = 17pt
5 \headheight = 12pt 6 \headsep = 25pt
7 \textheight = 598pt 8 \textwidth = 345pt
9 \marginparsep = 11pt 10 \marginparwidth = 57pt
11 \footskip = 30pt \marginparpush = 5pt (not shown)

\hoffset = 0pt \voffset = 0pt
\paperwidth = 597pt \paperheight = 845pt

Obrázek 2.9: Vykreslenı́ rozměrů stránky přı́kazem \layout

2.14 Pı́šeme pro vědu

Tato kapitola nenı́ určena jen matematikům, ale všem, kdo pı́šou dokument s vě-
tami, důkazy, přı́klady či jinými podobnými prostředı́mi (to se týká téměř všech
vědnı́ch oborů), vytvářejı́ struktury či diagramy (také třeba lingvisté) nebo pı́šou
postupy (algoritmy).
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2.14.1 Definice, věty a důkazy

Exaktnı́ věda je postavena na logice a logickém deduktivnı́m vyvozovánı́. To zna-
mená, že v každém vědnı́m oboru máme základnı́ pojmy a základnı́ (odpozorované)
vztahy, a pak všechno ostatnı́ – dalšı́ pojmy, které definujeme pomocı́ základnı́ch
nebo již definovaných pojmů, a odvozené vztahy (věty, teorémy, lemmata), které
jsme odvodili pomocı́ základnı́ch nebo již odvozených vztahů.

Pokud se pohybujeme i v teoretické části některého vědnı́ho oboru, potřebujeme
občas psát vlastnı́ definice pojmů (i dřı́ve definovaných, pro připomenutı́) a také
vlastnı́ věty, teorémy („důležitějšı́“, nové věty), lemmata (pomocné věty) a zapisovat
jejich důkazy. Dalšı́m prvkem z této oblasti jsou přı́klady, ukázky, úlohy a poznámky
vysvětlujı́cı́ či doplňujı́cı́ věty a definice.

Pro zápis těchto prvků existujı́ určité konvence. Definice, různé druhy vět a po-

známky se sázejı́ kurzı́vou, vyznačuje se v nich zrušenı́m kurzı́vy (tedy v LATEXu
prostě použijeme přı́kaz \emph), jsou čı́slovány. V článku čı́slovánı́ nezávisı́ na čı́sle
kapitoly, ale v rozsáhlejšı́m textu (třeba diplomové práci) ano.

Důkazy se nečı́slujı́, přı́slušejı́ vždy k určité větě a hned za nı́ bývajı́ uváděny
(pokud z nějakého důvodu musı́ být dál, třeba když za větu chceme vložit lemma
s důkazem ulehčujı́cı́ důkaz té věty, bývá za označenı́m důkazu v hranatých zá-
vorkách odkaz na větu, kterou dokazujeme). Důkazy již nesázı́me kurzı́vou, ale
normálnı́m pı́smem.

Přı́klady, ukázky či úkoly bývajı́ čı́slovány, pro čı́slovánı́ platı́ totéž co pro věty,
a stejně jako u důkazů použı́váme normálnı́ řez pı́sma.

Pro čı́slovánı́ se použı́vajı́ čı́tače, jakési proměnné, které se při každém použitı́
zvýšı́ o 1. Různé prvky mohou mı́t různé čı́tače, ale často se setkáváme s tı́m, že
třeba všechny druhy vět použı́vajı́ tentýž čı́tač.

LATEX nám dává možnost vytvářet si svá vlastnı́ prostředı́ s takovým označe-
nı́m a čı́slovánı́m, jaké budeme chtı́t. Tuto problematiku jsme už trochu nakousli
v kapitolách 2.6.2 o stylech a 2.8 o křı́žových odkazech.

Nové prostředı́ tohoto typu vytvořı́me pomocı́ přı́kazu \newtheorem, kde zadá-
váme titulek prostředı́ a určujeme způsob čı́slovánı́, které může být závislé na čı́slu
kapitoly, přı́padně lze čı́slovánı́ propojit s jiným takovým prostředı́m. Ukázku máme
ve výpisu 2.45.

Výpis č. 2.45

\newtheorem{veta}{Věta}[section] % prostředı́ závislé na čı́slovánı́ kapitol section
\newtheorem{lemma}[veta]{Lemma} % prostředı́ čı́slované zároveň s prostředı́m veta
\newtheorem{pozorovani}{Pozorovánı́}[section]
\newtheorem{definice}{Definice}[section] % prostředı́ pro definice
\newtheorem{thpriklad}{Přı́klad} % „meziprodukt“, použito dále:
\newenvironment{priklad}%

{\begin{thpriklad}\normalfont}%
{\end{thpriklad}}

\newenvironment{dukaz}%
{\textbf{Důkaz:\quad}}%
{$\Box$} % pro tento přı́kaz je nutno načı́st balı́ček latexsym nebo amssymb

Ukážeme si použitı́ prostředı́ definovaných ve výpisu 2.45. Všimněte si ukončenı́
prostředı́ pro důkazy – prázdný čtvereček se pro tyto účely použı́vá dost často, má
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zde význam „hotovo“.

Výpis č. 2.46

\begin{definice} Řı́káme, že sněžı́, pokud
padajı́ sněhové vločky.
\end{definice}

\begin{definice} Snı́h je hmota složená
ze sněhových vloček.
\end{definice}

\begin{pozorovani}\label{poz:snihmraky}
Sněhové vločky padajı́ z~tmavě
šedých mraků.
\end{pozorovani}

\begin{lemma} Když padá snı́h, jsou na
obloze šedé mraky.
\end{lemma}

\begin{dukaz} Plyne z~Pozorovánı́
\ref{poz:snihmraky}).
\end{dukaz}

\begin{veta} Když venku sněžı́, je
teplota menšı́ než 5~\celsius.
\end{veta}

\begin{dukaz} Sněhové vločky se pohybujı́
vzduchem. Pokud je teplota blı́zko země
5~\celsius nebo vyššı́, vločky roztávajı́
ještě ve vzduchu a~padá déšt’.
\end{dukaz}

\begin{priklad} Podı́váme se na oblohu.
Co tam vidı́me? Pokud šedé mraky, můžeme
očekávat sněženı́.
\end{priklad}

Definice 2.1 Řı́káme, že sněžı́, pokud

padajı́ sněhové vločky.

Definice 2.2 Snı́h je hmota složená

ze sněhových vloček.

Pozorovánı́ 2.1 Sněhové vločky pa-

dajı́ z tmavě šedých mraků.

Lemma 2.1 Když padá snı́h, jsou na

obloze šedé mraky.

Důkaz: Plyne z Pozorovánı́ 2.1. 2

Věta 2.2 Když venku sněžı́, je teplota

menšı́ než 5 °C.

Důkaz: Sněhové vločky se pohybujı́
vzduchem. Pokud je teplota blı́zko
země 5 °C nebo vyššı́, vločky roztá-
vajı́ ještě ve vzduchu a padá déšt’. 2

Přı́klad 1 Podı́váme se na oblohu. Co
tam vidı́me? Pokud šedé mraky, mů-
žeme očekávat sněženı́.

Existujı́ balı́čky, které rozšiřujı́ naše možnosti, napřı́klad ntheorem. Dále v téměř
každém balı́čku se třı́dami nebo styly pro odborné články nebo rozsáhlejšı́ práce bý-
vajı́ tato prostředı́ předdefinována.

2.14.2 Vzorce nejen matematické

Matematici, fyzikové, chemici, ekonomové a dalšı́ obyvatelé této planety občas po-
třebujı́ zapsat vzorec či vı́ce zarovnaných vzorců, a to bud’ samostatně na řádku
(přı́padně s čı́slovánı́m), nebo v odstavci s textem.

Jednoduché vloženı́ takového výrazu do textu jsme už vlastně použı́vali – napřı́-
klad výraz x = y+2/5 vysázı́me sekvencı́ $x=y+2/5$. Když tuto sekvenci ohraničı́me
mı́sto symbolů $ jejich dvojicemi (tedy $$x=y+2/5$$), vysázı́ se výraz na samostatný
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řádek.

Výrazy na samostatném řádku by správně měly být ve většině přı́padů čı́slo-
vány, aby bylo možné na ně odkazovat. Pak mı́sto symbolů $ použijeme matema-
tická prostředı́ equation (jeden řádek) nebo eqnarray (i vı́ce řádků s možnostı́ určit
zarovnánı́ pomocı́ symbolu &, viz přı́klad 2.21, ale nemusı́me použı́t). Na řádky mů-
žeme přidat přı́kaz \label a pak jeho argument použı́vat pro zı́skánı́ čı́sla rovnice.
Když určitý řádek v soustavě nechceme mı́t čı́slovaný, použijeme na tomto řádku
přı́kaz \nonumber.

Pro samotný obsah těchto matematických úseků nebo prostředı́ využı́váme
nejen matematické operátory, ale také funkce, speciálnı́ symboly a přı́padně i řec-
kou abecedu. To nejzákladnějšı́ najdeme obvykle v menu nebo panelech nástrojů
editoru, u editoru TEXnicCenter bud’ na jednom panelu nástrojů nebo v menu Insert

→ Formulas (ohraničenı́ matematických prostředı́) a Math (všechno ostatnı́).

Přı́klad 2.21 Ukážeme si zápis čı́slované rovnice a soustavy rovnic, a také odkaz
na rovnici. Soustava rovnic bude zarovnána podle operátorů rovnosti a nerovnosti.
Všimněte si způsobu zarovnánı́ pomocı́ & v prostředı́ eqnarray.

Výpis č. 2.47

Rovnice:
\begin{equation}
x=y+2/5\label{eq:rovnice}
\end{equation}

To byla rovnice (\ref{eq:rovnice}).

Soustava:
\begin{eqnarray}
y-5+\frac{-x}{3} & \leq & \sqrt{2}*x

\label{eq:deleniodmocninou}\\
x/2+y & < & 0 \nonumber\\
\sin(x)+1 & \geq & \cos(y)\\
xˆ2+yˆ{2n}-xˆ{2ˆt}& = & vysl 3\\
vysl 2 & = & \sum {i=1}ˆn xˆi\nonumber
\end{eqnarray}

Prvnı́ rovnice soustavy je
(\ref{eq:deleniodmocninou}).

Rovnice:

x = y + 2/5 (2.1)

To byla rovnice (2.1).

Soustava:

y − 5 + −x

3
≤
√
2 ∗ x (2.2)

x/2 + y < 0

sin(x) + 1 ≥ cos(y) (2.3)

x2 + y2n − x2
t

= vysl3 (2.4)

vysl2 =
n∑

i=1

xi

Prvnı́ rovnice soustavy je (2.2).

To, že máme k dispozici spoustu různých symbolů z různých vědnı́ch oborů,
už vı́me (viz strana 50 v kapitole 2.4.4), ale podpora pro tyto účely je v LATEXu mno-
hem širšı́. Ve třı́dách a stylech pro specializované odborné časopisy a jiné publikace
najdeme mnohá užitečná nastavenı́, prostředı́ a přı́kazy, a také existuje mnoho
balı́čků se styly pro různé účely. Napřı́klad balı́ček xymtex je určen pro vytvářenı́
formulı́ s chemickými strukturami, tensor obsahuje podporu sázenı́ tenzorů s hor-
nı́mi i dolnı́mi indexy správně zarovnanými, xlop dokáže nejen formátovat, ale také
provádět matematické výpočty, atd.
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2.14.3 Stromové struktury, diagramy a grafy

Pro strukturovaná data samozřejmě můžeme použı́t prostředı́ picture nebo některý
balı́ček, který rozšiřuje jeho možnosti, ale máme také k dispozici balı́čky určené
přı́mo pro tyto účely.

Stromové (nebo jakkoliv rozvětvené) struktury můžeme vytvořit pomocı́ růz-
ných balı́čků, napřı́klad tree-dvips, xyling, trees, qtree, ps-trees, atd. Vět-
šina z nich použı́vá pro vykreslovánı́ čar a křivek Postscript, proto je třeba formát
PDF tvořit přes formát PS (v TEXnicCenter profil překladu LaTeX=>PS=>PDF).

Přı́klad 2.22 Ve výpisu a na výsledku máme ukázku použitı́ balı́čku tree-dvips.
Vykreslı́me celkem šest uzlů, které jsou nazvány x, y, z, u, v, p (na tyto názvy se
odkazujeme v dalšı́ch přı́kazech) a každý má svůj text (napřı́klad uzel x má text
Hornı́ uzel). Uzly umı́stı́me pomocı́ tabulky.

Pak propojı́me uzly čárami, šipkami, křivkami (zde musı́me zadat, jak moc bude
„vykřivená“) a křivkami se šipkou. U všech těchto prvků můžeme v nepovinných
parametrech určit body, ze kterých a do kterých čára nebo křivka povede. Napřı́klad
pı́smenko t určuje hornı́ část uzlu, bl spodnı́ levou (bottom-left) část.

Výpis č. 2.48

% Nejdřı́v vytvořı́me a umı́stı́me uzly:
\begin{tabular}{ccc}

& \node{x}{Hornı́ uzel}\\[2em]
\node{y}{Levý}&&\node{z}{Pravý}\\[2em]

& \node{u}{Prostřednı́ uzel}\\[1ex]
\node{v}{Dno}&&\node{p}{Poslednı́}
\end{tabular}
% Orámujeme prvnı́ uzel:
\nodebox{x}
% Nakreslı́me čáry:
\nodeconnect{x}{y}
\nodeconnect{x}{z}
% Nakreslı́me šipky:
\anodeconnect{y}{u}
\anodeconnect{z}{u}
\anodeconnect[br]{x}[tr]{z}
% Nakreslı́me křivku a křivku s šipkou:
\nodecurve[l]{x}[l]{v}{1.6cm}
\anodecurve[b]{u}[r]{v}{.7cm}
% „Rovná“ šipka dole:
\abarconnect[-8pt]{v}{p}

Hornı́ uzel

Levý Pravý

Prostřednı́ uzel

Dno Poslednı́

Dále si ukážeme použitı́ některých přı́kazů balı́čku pstricks. Jak název na-
povı́dá, opět budeme překládat přes formát PS. Samotný balı́ček nabı́zı́ spoustu
přı́kazů souvisejı́cı́ch s grafikou, my si zde ukážeme jen to nejzákladnějšı́ – čáry
s různými zakončenı́mi a křivku. Tento balı́ček nelze použı́vat zároveň s balı́čkem
color, což ale nevadı́, protože má vlastnı́ (a dokonalejšı́) správu barev. Máme k dis-
pozici prostředi pspicture podobné již známému prostředı́ picture, předdefino-
vané jednotky jsou však centimetry, ne body.
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Výpis č. 2.49

\begin{pspicture}(6,3)
% Lomená čára:
\psline(0,2)(2,3)(4,3)
% Šipky:
\psline[arrows=*->,linewidth=.5pt](0,1)(2,2)
\psline[arrows=|->>,linewidth=.5mm](0,0)(2,1)
% Křivka:
\pscurve(2,0)(4,1)(5,.2)(3.5,.7)(3,2)
\end{pspicture}

Dalšı́ možnosti nám poskytne kombinace balı́čku pstricks a některého dal-
šı́ho, napřı́klad ps-plot (tj. přı́kazem \usepackage načteme nejdřı́v pstricks
a pak ještě ps-plot), v našem přı́padě máme k dispozici kromě jiného přı́kazy
k vykreslovánı́ funkcı́:

Výpis č. 2.50

\begin{pspicture}(0,0)(4,5)
% Soustava souřadnic:
\psaxes(0,0)(-3,-3)(3,2)
% Funkce:
\psplot{-2}{2}{x 3 exp 4 div 0.5 sub}
\end{pspicture}(6,3) 1 2 3−1−2−3

1

2

−1

−2

−3

Prvnı́ přı́kaz vykreslı́ soustavu souřadnic, druhý přı́kaz funkci x3/4 − 0.5 na
intervalu x ∈< −2, 2 > (to jsou prvnı́ dva parametry)12.

Pro vkládánı́ grafů a jiných složitých nákresů opět existuje vı́ce možnostı́. Ně-
které balı́čky dokážou vykreslit jednoduché funkce přı́mo (to jsme viděli u pstricks
+ ps-plot), pro složitějšı́ nebo vı́cerozměrné funkce je lepšı́ využı́t specializované
nástroje. Máme dvě základnı́ možnosti:

a) použijeme kterýkoliv program pracujı́cı́ s grafikou nebo přı́mo s grafy a uložı́me
či exportujeme obrázek do vhodného formátu (většina těchto programů zvládá

12Zápis funkce je v postfixu, kdy se nejdřı́v pı́šou oba operátory a pak název funkce nebo operátor,
napřı́klad 4 + 5 se zapı́še jako 4 5 + nebo výraz 2 ∗ x+ 4 jako 2 x ∗ 4 +.

Postfixový zápis vytvořı́me jednoduše: nejdřı́v si „uzávorkujeme“ celý výraz, napřı́klad a+2∗x+4−z

uzávorkujeme na (((a + (2 ∗ x)) + 4) − z), postupujeme podle toho, které operátory majı́ přednost,
v přı́padě několika se stejnou přednostı́ (třeba +,-) postupujeme zleva. Pak jdeme od nejvnitřnějšı́ch
závorek – nejdřı́v napı́šeme 2 x ∗, pak řešı́me + s výsledkem a 2 x ∗ + (operátor přidáváme na konec,
operandy podle pořadı́ v původnı́m výrazu), atd., v našem přı́padě bude výsledek a 2 x ∗ + 4 + z −.
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export do EPS, PDF nebo něčeho převeditelného na tyto formáty) – Mathematica,
Inkscape ([P20]), Corel, apod., výborným a přitom volně šiřitelným programem
speciálně pro tyto účely navrženým je GNUPlot ([P21], pěkný úvod na [P22]),

b) existujı́ programy vytvářejı́cı́ přı́mo TEXový kód – LATEXPiX ([P23]), TEXcad32

([P24]), TEXCAD ([P25]), atd.

2.14.4 Postupy, algoritmy, předem zformátovaný text

V odbornějšı́ch publikacı́ch včetně diplomových pracı́ je někdy třeba vložit struktu-

rovaný postup nějaké činnosti. Nejde jen o algoritmus při programovánı́, ale obecně
o jakýkoliv postup nebo způsob konstrukce, který chceme napsat co nejpřehledněji.
LATEX nám opět nabı́zı́ několik balı́čků, z nichž jsou zajı́mavé napřı́klad algorithm2e,
algorithmicx, pseudocode, newalg. Některé z nich, napřı́klad algorithm2e, nabı́zejı́
možnost vygenerovat seznam algoritmů podobně jako generujeme třeba obsah nebo
seznam obrázků (přı́kaz je \listofalgorithms, v přı́padě uvedeného balı́čku má
i podporu češtiny).

Přı́klad 2.23 Ukážeme si základnı́ možnosti balı́čku alorighm2e. Balı́ček na-
čteme následujı́cı́m přı́kazem (v preambuli) s nepovinnými parametry pro vzhled
a nastavenı́ češtiny v popiscı́ch a seznamu algoritmů:

\usepackage[ruled,vlined,czech]{algorithm2e}

Dále vytvořı́me dva algoritmy. Prvnı́ popisuje postup při přecházenı́ křižovatky (bez
světelné signalizace), druhý postup čtenı́ detektivky. U druhého postupu budeme
chtı́t očı́slovat řádky.

Výpis č. 2.51

\begin{algorithm}[H]
přı́chod ke křižovatce\;
\Repeat{nejede auto}{

pohlédni vlevo\;
\While{jede auto}{čekej\;
pohlédni vpravo\;
\While{jede auto}{čekej\;
pohlédni vlevo\;

}
přejdi\;
\caption{Přechod křižovatky}
\label{alg:krizovatka}
\end{algorithm}

Algoritmus 1: Přechod křižovatky

přı́chod ke křižovatce;
repeat

pohlédni vlevo;
while jede auto do

čekej;

pohlédni vpravo;
while jede auto do

čekej;

pohlédni vlevo;
until nejede auto;
přejdi;
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Výpis č. 2.52

\linesnumbered
\begin{algorithm}[H]
vezmi knihu\;
otevři knihu na prvnı́ straně\;
\While{nenı́ konec knihy}{

čti kapitolu\;
\eIf{rozumı́š kapitole}{
přesuň se na dalšı́ kapitolu\;
\If{vı́š kdo je vrah}{

přestaň čı́st\;}
přesuň se na konec knihy\;

}
}{
zpět na začátek kapitoly\;

}
}
\caption{Hledánı́ vraha}
\label{alg:hledanivraha}
\end{algorithm}

Algoritmus 2: Hledánı́ vraha

vezmi knihu;1

otevři knihu na prvnı́ straně;2

while nenı́ konec knihy do3

čti kapitolu;4

if rozumı́š kapitole then5

přesuň se na dalšı́ kapitolu;6

if vı́š kdo je vrah then7

přestaň čı́st;8

přesuň se na konec knihy;9

else10

zpět na začátek kapitoly;11

Jak vidı́me, vlastně jde o nový typ plovoucı́ch prostředı́. Pokud se prostředı́
nevejde celé na stránku, kde je zadáno, vysázı́ se až na dalšı́ stránku, „poplave“
v textu o něco dál. Pokud tomuto chovánı́ chceme zabránit (nebo při umı́stěnı́ do
prostředı́ minipage), použijeme nepovinný parametr H.

K postupům charakteru „programovacı́ho“ nebo výpisům textových souborů
patřı́ možnost vložit text „tak jak je“, tedy včetně přı́padných speciálnı́ch znaků, na
které by LATEX nějakým způsobem reagoval, mezer a konců řádků. K tomu sloužı́
bud’ přı́kaz \verb nebo prostředı́ verbatim či alltt.

Přı́kaz \verb má trochu zvláštnı́ použitı́. To, co chceme pomocı́ tohoto přı́kazu
vložit, ohraničı́me jakýmkoliv symbolem, který se v ohraničovaném textu nenacházı́
(stejný symbol před i za textem, tedy ne levá a pravá závorka!), napřı́klad:

Výpis č. 2.53

\verb+http://www.adresa.cz+\\
přı́kaz \verb \verb \\
soubor \verb|\C:\dokumenty\zivotopis.txt|

http://www.adresa.cz
přı́kaz \verb
soubor
C:\dokumenty\zivotopis.txt

Prostředı́ verbatim pracuje jako jiná prostředı́, tedy text, který chceme nechat
zachovaný tak, jak je (včetně konců řádků apod.), umı́stı́me mezi \begin{verbatim}
a \end{verbatim}.

Prostředı́ alltt z balı́čku alltt (tento balı́ček musı́me samozřejmě načı́st) je
svou funkcı́ podobné verbatim, ale navı́c interpretuje některé přı́kazy LATEXu. Toto
prostředı́ použı́váme, pokud chceme zachovávat mezery a konce řádků, ale navı́c
použı́váme barvy, řezy a dalšı́ přı́kazy.



KAPITOLA 2 TYPOGRAFICKÝ SYSTÉM TEX 100

Úlohy:

1. Vytvořte nový dokument třı́dy article se základnı́ velikostı́ pı́sma 10 bodů.

2. Do preambule dokumentu napište tento přı́kaz (vytvořenı́ přı́kazu pro kapi-
tolu): \newcommand{\kapitola}[1]{\section{#1}}

3. Nadefinujte si podobný přı́kaz pro podkapitolu:
\podkapitola{Název podkapitoly}
odkazujı́cı́ pro změnu na přı́kaz \subsection s předánı́m parametru.

4. Oba tyto přı́kazy pro kapitolu a podkapitolu použijte v dokumentu (překládejte
do DVI), přidejte také běžný text, v něm některá slova vyznačte vhodným řezem.

5. Změňte třı́du dokumentu na report a dále v definicı́ch přı́kazů \kapitola
a \podkapitola změňte odkazy na přı́kazy \chapter a \section (opět s pře-
dánı́m parametrů), aby nadpisy odpovı́daly použitı́ v této třı́dě.

6. Vytvořte a umı́stěte titulnı́ stranu. Zvolte nadpis a sebe napište jako autora.

7. Na konci dokumentu vytvořte seznam literatury s alespoň dvěma položkami
(vhodně formátovanými). Do prvnı́ kapitoly umı́stěte citaci některé z položek
seznamu literatury.

8. V některé z kapitol vytvořte jednoduchý obrázek (nákres – pomocı́ prostředı́
picture), přidejte titulek (tj. vložte tento obrázek do přı́slušného plovoucı́ho
prostředı́).

9. V některé z kapitol vytvořte jednoduchou tabulku s obsahem podle vlastnı́ho
výběru (alespoň dva sloupce a alespoň dva řádky), orámovánı́ si zvolte sami.
Tabulku umı́stěte do přı́slušného plovoucı́ho prostředı́.

10. Za titulnı́ stranu (tj. před kapitoly) umı́stěte obsah, seznam tabulek a seznam

obrázků.

11. Z tohoto dokumentu vytvořte PDF soubor.
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[C5] OLŠÁK, P.: Kam se poděla dobrá typografie? In: Mensa 5/96, s. 37–42. [online],
1996.
URL: http://petr.olsak.net/ftp/olsak/typo/mensa.pdf
[cit. 5. 2. 2007]

— Diplomové práce —
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čı́slovaný. . . . . . . . . . . . . . . . . . . . . . . . .60
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výčtový. . . . . . . . . . . . . . . . . . . . . . . . . . .54
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stupeň . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

pı́sma.. . . . . . . . . . . . . . . . . . .44, 45, 56
styl . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .52, 56
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tabulátor. . . . . . . . . . . . . . . . . . . . . . . . . . . . .78
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trojtečka . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
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